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Getting Started

Simulink® Verification and Validation uses component tools that contribute
to the work of certifying the correct design, implementation, and testing of
Simulink models. Use the following topics to introduce yourself to Simulink

Verification and Validation.

“What Is Simulink Verification and
Validation?” (p. 1-2)

“System Requirements” (p. 1-3)

“Organization of This User’s Guide”
(p. 1-4)

Tells you why you want to use
Simulink Verification and Validation
in your models

Lists system requirements necessary
to qualify for installation

Describes the expected background
for using Simulink Verification and
Validation and the organization of
this guide
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What Is Simulink Verification and Validation?

Simulink Verification and Validation is a Simulink® based product that helps
you do the following:

e FEstablish requirements for a Simulink model by linking them with model
elements that satisfy them

® Verify proper function of the model by monitoring model signals during
extensive testing

e Validate the model, making sure that all possible model decisions are taken
through testing.

In short, the elements of Simulink Verification and Validation give you
complete confidence in the behavior of your Simulink models.



System Requirements

System Requirements

Operating System Requirements

Simulink Verification and Validation works with the following operating
systems:

Microsoft Windows NT, Windows 2000, and Windows XP systems

UNIX systems where MATLAB supports Java (for HTML-based
requirements documents only)

MATLAB Requirements

To use Simulink Verification and Validation in MATLAB®, you need the
following software products installed:

MATLAB Version 5.3.1 or later
Simulink Version 3.0.1 or later

Stateflow® Version 2.0.1 or later, if you want to use the Requirements
Management Interface for Stateflow diagrams

For the Simulink Verification and Validation version of the Requirements
Management Interface, you need the applications that you use to view your
requirements documents. The following applications are supported:

= Microsoft Word 2000 or later
= Microsoft Excel 98 or later

For the Simulink Verification and Validation version of the Requirements
Management Interface with DOORS, install DOORS version 6.0 or 7.0. For
older DOORS versions, use the old Requirements Management Interface as
follows:

= To use Version 4.0.3 of DOORS, you need Version 1.0 of the Requirements
Management Interface

= To use Version 5 of DOORS, you need Version 1.02 of the Requirements
Management Interface.

= To use Version 5.2 of DOORS, you need Version 1.04 of the Requirements
Management Interface.

1-3
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Organization of This User’s Guide

The components of the Simulink Verification and Validation tools are
organized on the basis of work flow that you follow in certifying the correct
and complete behavior of your models. This work flow is described in the
following steps, which encapsulate the organization of this User’s Guide:

1 Establish performance requirements for the model and link them with
model elements using the Requirements Management Interface, which is
described in the following chapters:

® Chapter 2, “Managing Model Requirements” — Instructions for using
the standard version of the Requirements Management Interface. Use
this to associate Simulink models, Stateflow diagrams, and MATLAB
M-files with requirements in HTML, Microsoft Word, and Microsoft
Excel documents.

® Chapter 3, “Managing Model Requirements with DOORS” —
Instructions for using the DOORS version of the Requirements
Management Interface. Use this if you use the DOORS requirements
management system and want to associate Simulink models, Stateflow
diagrams, and MATLAB M-files with requirements in DOORS.

2 Verify proper performance of the model by monitoring model signals during
extensive testing with model verification blocks using the Verification
Manager, which is described in the following chapter:

® Chapter 4, “Managing Model Verification Blocks” — Shows you how
to use verification blocks individually in Simulink models and how to
manage them as a group for testing.

3 Validate the model, making sure that all possible model decisions are taken
through testing, by using the Model Coverage tool, which is described in
the following chapter:

e Chapter 5, “Using Model Coverage” — Shows you how to generate and
interpret model coverage reports and displays for validating model
decisions.

The last portion of the User’s Guide is comprised of function and block
reference chapters:
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e Chapter 6, “Functions — Categorical List” — Provides a categorical list
of functions used in executing and managing model coverage tests and
reports from MATLAB. Automate your model coverage tests with scripts
of MATLAB commands calling these functions.

¢ Chapter 7, “Functions — Alphabetical List” — Provides an alphabetical
reference of functions used in executing and managing model coverage
tests and reports from MATLAB.

e Chapter 8, “Blocks — Alphabetical List” — Provides reference information
for the Simulink Verification and Validation library, which currently
contains only one block, System Requirements. This block lets you list all
the requirements for a model or subsystem on its Simulink diagram.

1-5
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Managing Model
Requirements

The Requirements Management Interface (RMI) associates requirements
documents with objects in Simulink models. To learn how to use the RMI, see

the following sections:

“What Is the Requirements
Management Interface?” (p. 2-3)

“Configuring the Requirements
Management Interface” (p. 2-4)

“Adding and Viewing Requirement
Links” (p. 2-5)

“Linking to Custom Types of
Requirements Documents” (p. 2-28)

“Viewing Objects with Requirement
Links” (p. 2-44)

“Generating a Requirements Report”
(p. 2-47)

Introduces you to the Requirements
Management Interface for linking
requirements documents to model
elements

Describes what you need to do
before using the Requirements
Management Interface

Shows you how to link model
elements with requirements
documents, and modify both links
and documents

Shows you how to register additional
types of requirements documents
and create links to them

Shows you how to provide
meaningful displays of model
elements that are linked to
requirements documents

Shows you how to generate a report
on all the requirements associated
with a model and its blocks
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“Displaying the System
Requirements in a Diagram”
(p. 2-49)

“Including Requirements with
Generated Code” (p. 2-55)

Shows you how to display the
system requirements directly in your
Simulink diagram

Shows you how to specify that
requirements descriptions are
included in generated code for your
model



What Is the Requirements Management Inferface?

What Is the Requirements Management Interface?

The Requirements Management Interface (RMI) allows you to associate
requirements with Simulink models and Stateflow diagrams. Simulink and
Stateflow requirements have the following parts:

® A requirement description of up to 255 characters

® The pathname of a requirements document, such as a Microsoft Word file.
(Simulink supports several built-in document formats and also allows you
to register your own custom types of requirements documents.)

® A link to a location inside the requirements document
Use the Requirements Management Interface to

® Associate requirements with
= Simulink models
= Simulink subsystems and blocks
= Stateflow charts, states, transitions, boxes, and functions

® Navigate from a Simulink block or Stateflow object in a diagram or in the
Model Explorer to a requirement

® Navigate from an embedded link in a requirements document to the
corresponding Simulink or Stateflow object (when you create two-way links
using the selection-based linking mechanism)

® View objects in Simulink or Stateflow diagrams that have requirements
associated with them

2-3
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Configuring the Requirements Management Interface

Before you start using the Requirements Management Interface, in the
MATLAB Command Window type

rmi setup

This command runs a setup script that installs the ActiveX controls, needed
for establishing two-way selection-based links. If DOORS is installed on
the machine, this command also invokes the DOORS setup. For more
information, see “Configuring the Requirements Management Interface for
DOORS” on page 3-3.
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Adding and Viewing Requirement Links

Adding and Viewing Requirement Links

You use the Requirements dialog box to associate a requirements document
with a requirements object.

Use the following topics to learn how to add, view, and modify requirements
you associate with a requirements object:

® “Object and Document Types” on page 2-5 — Learn about the supported
types of objects, requirements documents, and locations within the
documents.

® “Adding Requirement Links to an Object” on page 2-8 — Make a link
between a model element and a requirements document.

* “Viewing Requirements Documents” on page 2-13 — Edit a requirements
document through the model element it is linked to.

¢ “Resolving the Document Path” on page 2-15 — Learn where the
Requirements Management Interface looks to resolve the absolute or
relative path you specify for a requirement.

® “Adding Requirement Links to Multiple Objects Simultaneously” on page
2-17 — Make a link between each of a group of selected model elements
and a requirements document.

® “Selection-Based Linking” on page 2-20 — Use a simplified procedure
to make a two-way link between a model element and a requirements
document.

Object and Document Types

You can add requirements to the following types of objects:

e Simulink model
e Simulink block

e Stateflow chart, state, transition, box, or function

2-5
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Note You can add requirements to top-level reference blocks but not to their
contents. For example, if you copy a subsystem consisting of multiple blocks
from a library, you will be able to add requirements to the subsystem block in
your model, but not to its component blocks.

The Requirements Management Interface supports the following built-in
types of requirements documents:

o Text

HTML

® Microsoft Word

Microsoft Excel

e PDF

You can also link to a DOORS item (see “Linking Objects to DOORS
Requirements” on page 3-7), or register your own custom type of documents
to link to (see “Linking to Custom Types of Requirements Documents” on
page 2-28).

Location Types

Depending on the document type, you can link to specific locations within
a document.

Document | Location Options
Type

Text e Search text — Type a string in the Location text field.
The Requirements Management Interface searches for the
first occurrence of the text string within the document.

® Line number — Type a line number in the Location text
field. The Requirements Management Interface makes a
link to the specified line.

2-6
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Document
Type

Location Options

HTML

You can only link to a named anchor.

For example, if you define the anchor

<A NAME=valve_timing> ...contents... </A>

in your HTML requirements document, you can enter
valve_timing in the Location text field or click the
Document Index tab to select valve timing from an
automatically generated list of anchors in the document.

Microsoft
Word

e Search text — Type a string in the Location text field.
The Requirements Management Interface searches for the
first occurrence of the text string within the document.

® Named item — Link to a bookmark within the document.
The Requirements Management Interface automatically
generates a document index based on its headings and
bookmarks, or you can type the name in the Location
text field.

® Page/item number — Type a page number in the Location
text field. The Requirements Management Interface makes
a link to the top of the page.

Microsoft
Excel

e Search text — Type a string in the Location text field.
The Requirements Management Interface searches for the
first occurrence of the text string within the document.

e Named item — Link to a named item within the document
(defined in Excel using Insert —> Name). Type the name
in the Location text field.

® Sheet range — Type a cell number or a range of cells (such
as C5:D7) in the Location text field. The Requirements
Management Interface makes a link to the specified cell
or cells.

2-7
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Document | Location Options

Type

PDF e Named item — Link to a bookmark within the document.
The Requirements Management Interface automatically
generates a document index based on its headings and
bookmarks, or you can type the bookmark name in the
Location text field.

® Page/item number — Type a page number in the Location

text field. The Requirements Management Interface makes
a link to the top of the page.

Web You can only link to a URL location. Type the URL location

Browser string in the Document text field. When you follow the link,

URL the document opens in the system Web browser.

Adding Requirement Links to an Object

You can link a particular location in an existing Microsoft Word or HTML
document to a block in a Simulink diagram or a Stateflow object in a Stateflow
diagram. In the following procedure, you add three requirement links to a
Simulink block in the demo model sf_car. In later topics you modify both the
links and the documents they point to.

1 Create and save the Microsoft Word document requirements.doc with
the following format:

Primary Requirements
<filler text - 10 lines>

Secondary Requirements
<filler text - 10 lines>

Tertiary Requirements
<filler text - 10 lines>

2 Open the demo model sf_car by typing sf_car at the MATLAB prompt.

3 Right-click the Engine block and, from the resulting pop-up menu, select
Requirements > Edit/Add Links.

The Requirements dialog box for the Engine block appears, as shown.



Adding and Viewing Requirement Links

E! Requirements: Engine

IDDcumentlndeH |

Mew
Capy
Delete
Up

Down

4dds

Dezcription: I

Diocument: I

]

Diocument type: I |dnzpecified Type

j Browse... |

Location:
e |
|Jzer tag: I
Lpskiz ekb ol pooRs || wed | Ewel |
current selection in:
ok I Cancel | Help | Apply |

You can access the Requirements dialog box to add requirements in the
following right-click contexts.

Model Element

Context

Simulink model

Simulink diagram — Empty diagram space

Simulink block

Simulink diagram
Model Explorer Contents pane

Stateflow chart

Simulink diagram — Stateflow block
Stateflow Diagram — Empty diagram space

Stateflow object

Stateflow diagram
Model Explorer Contents pane

4 In the Requirements dialog box, click New to add a new default

requirement.
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2 Managing Model Requirements

Fields and tools of the Requirements dialog box are now enabled for a
default unspecified requirement, as shown.

E! Requirements: Engine ll

Requirements IDocumEandBH |

<Muo dezcription entered:

Copy
Delete
Up

Down

_ o |
R
|
[ o

Dezcription: |<Nn description entered:

Diocument: I LI

Diocument type: IUnspecifiedT_l,Jpe j Browsze... |

Location:
(Tuperldentiier] | 5527ch test |

|Jzer tag: I

Lpskiz ekb ol pooRs | wod | Ewel |
current selection in:

ok | Cancel | Help | Apply |

5 Click in the Description field and enter Requirement 1.

6 Click Browse next to the Document Type field, browse to the requirement
file requirements.doc, and select Open.

Note that the Document Type field is now set to Microsoft Word. If you
specify the document type in the Document Type field prior to browsing
for the requirements document, only the files of the appropriate type are
shown in the browser. If you set Document Type to Unspecified Type,
the browser shows all files.

7 To define a particular location in the document, click the Document Index
tab and select Primary Requirements from an automatically generated list

2-10
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of headings and bookmarks in the document. Alternately, you can just type
Primary Requirements in the Location text field.

E! Requirements: Engine

Requirements IDocumEandBH |

X

New Requirement 1

Copy
Delete
Up

Down

ddd

Dezcription: |F| equirement 1

Document: ID:'\Work'\MWDWn\p"'\requirements.doc

Diocument type: I ticrozoft wWord

|
j Browse... |

Location: - - -
Tl I MHamed itern LI IF'nmary Hequwemenls{
|Jzer tag: I
Lpskiz ekb ol pooRs | wod | Ewel |
current selection in:
ok I Cancel | Help | Apply |

8 With Requirement 1 selected, click Copy to add a copy of Requirement 1

as a new requirement.

9 Modify the copy of Requirement 1 to be Requirement 2, pointing to the text
“Secondary Requirements” in the document requirements.doc.

In addition to the Copy tool, you can edit existing requirements using the

following tools.

Tool Button | Description

Delete

Deletes the requirement
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Tool Button | Description

Up Moves the selected requirement up one line in the list
of requirements

Down Moves the selected requirement down one line in the list
of requirements

As you add requirements, the Requirements dialog box makes it easier for
you to enter a previous document name by remembering up to five of the
most recent documents entered. The list of five is taken for all entries made
across all models. For example, if you were to add a new requirement after
entering two requirements for the Engine block, and click the drop-down
arrow in the Document field for the new requirement, a selectable list of
previous documents like the following example would appear.

E! Requirements: Engine ll

Requirements IDocumEandBH |

Requirement 1
Requirement 2
Copy <No description enterad:

Mew

Delete

Up

ddd

Down

Dezcription: |<Nn description entered:

Diocument: I

Diocument type:

[ L wfork b D v requirementz_blkmks. doc

Logatior: - Dok DAY v requirements 1. doc

[Type/ldentifier] * :

User tag: I

|Jpdate fields with DO0RS | word | — |

current selection in:

ok I Cancel | Help | Apply
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10 Click OK to apply the requirement links you have added and close the
Requirements dialog box.

Note When you add a requirement link to a block such as a subsystem, the
requirement is not added to children of the block.

11 Save the model as my sf car.mdl.

Viewing Requirements Documents

You can access a requirements document through its associated model
element. You added requirement links to the Engine block of the model
my_sf_car in “Adding Requirement Links to an Object” on page 2-8. To access
the document for the second requirement link, do the following:

1 Open the model my_sf _car that you saved in the previous topic, “Adding
Requirement Links to an Object” on page 2-8.

2 Right-click the Engine block and select Requirements from the context
menu.

The requirements you added now appear as submenu selections, as shown.
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-ioix

File Edit Wiew Simulstion Format Tools

Help

DeEH& & BR|5 2

| | 2 | ISD INormaI '“ @

sf_car.mdl

Uzar Inputs

E Brke ——
Thotte
Doubie-click to
open the GUI

and selectan
input maneuver

i thirottie

Engin

spaad
up_th

down_th
sh

down_th

Thresl

LT

irmpedler torque

Open Block
Open Block In Mew Window
Explore

Choose Start from
the Simul ation menu
to run the simul ation.
T

Cut

Copy
Delete

T
PR P

Wehicle
Smission

trrsmission spesd

IMask Farameters, .
SubSystem Parameters, ..
Block Properties. ..

Model Advisor. ..

PN requrererts )

Real-Time Warkshop »
Fixed-Paint Settings. ..

3 Select Requirement 2 from the submenu.

Linearize Elock. ..

Mask Subsystem, ..
Look Under Mask
Link @ptians 3

vd‘iclle
1. "Requirement 1" ele mph
2. "Requirement 2" lre llow]
tile %
Add link to Word selection §|
Add link to active Excel cell

Add link to current DOORS object
Edit/add Links ...
Link settings ...

Sinnal & Srane Manansr

[ |odes

The document requirements.doc opens in its editor, Microsoft Word,
scrolled to the highlighted first occurrence of the text “Secondary
Requirements,” as shown.

2-14




Adding and Viewing Requirement Links

i3} requirements.doc {Read-Only) - Microsoft Word

File  Edit

DEEHamn SR_RY FBBC o-c- @O E 4 B 5%
v show- | & ¥ p - K2~ (13- | E .
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If a string location in the file is not specified, the document appears scrolled
to the top of the file.

4 Try to access the other requirements and make sure that they open scrolled
to the specified text location.

Resolving the Document Path

Browsing for a document to enter it in a requirements link enters the location
of the document with a fully specified absolute path. You can also enter a
relative path for the document location. A relative path can be a partial path
or no path at all. In many cases it is preferable to use a relative path so that
the document is not constrained to a single location in the file system. With

a relative path the Requirements Management Interface resolves the exact
location of the requirements document with the following procedure:

1 An attempt is made to resolve the path relative to the current MATLAB
directory.

2 Ifthere is no path specification and the document is not in the current
directory, the MATLAB search path is used to locate the file.

3 If the document is not located relative to the current directory or the
MATLAB search path, it is resolved relative to the model file directory.
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The following examples illustrate the procedure for locating the specified
requirements document.

Relative Path Specified Example

Current MATLAB C:\work\scratch

directory:

Model file: C:\work\models\controllers\pid.mdl
Document link: ..\regs\pid.html

Documents searched for: | C:\work\regs\pid.html
(in order) C:\work\models\reqgs\pid.html

No Path Specified Example

Current MATLAB C:\work\scratch

directory:

Model file: C:\work\models\controllers\pid.mdl
Requirements pid.html

document:

Documents searched for: | C: \work\regs\scratch\pid.html
(in order) <MATLAB path dir>\pid.html
C:\work\models\controllers\pid.html

Absolute Path Specified Example

Current MATLAB C:\work\scratch

directory:

Model file: C:\work\models\controllers\pid.mdl
Requirements C:\work\reqgs\pid.html

document:

Documents searched for: | C: \work\regs\pid.html
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Adding Requirement Links to Multiple Objects
Simultaneously

In “Adding Requirement Links to an Object” on page 2-8, you added
requirement links to an individual block. You can also add or delete

requirement links for a selection of multiple Simulink blocks or Stateflow
objects as follows:

1 Open the demo model my_sf _car you saved in “Adding Requirement

Links to an Object” on page 2-8 and select the Engine, engine RPM, and
transmission blocks.

Selected blodks

LTE

File Edit ‘Wiew Simulation Format Tools  Help

hiz:

¥
F

sf_car.mdl % — ;:WLE ! Choose Start from
L’ * the Simel ation menu
T to run the sivail ation.

bl T
I <ngi WP
P 02ar
Engine E i
- ! -
Wit O e e ™
Usar Inputs — Vbicle
trRnsmiEsion
% Brke —— %}I
trarsmizsion speed
Thrztie
Doubie-click to
open the GUI
. and sefect an veticle
nput maneuver speed
wehizle mph
fyzllow)
Threshod Cakulation & thmttle %
o |
>
hl_@
|
Ready [1o02 [ [ |odes v

You can select multiple Simulink blocks or Stateflow objects in one of the
following ways:

* Hold down the Shift key while clicking each block.

® (Click and drag a selection rectangle around them.
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2 Right-click any of the selected blocks and, from the resulting context menu,
select Requirements > Add Links to All.

The Add Requirements dialog box appears, as shown, for the three selected
blocks.

[Z]add requirements: 3 objects selected |

I Document Index |

Mew
Capy
Delete
Up

Down

4dds

Dezcription: I

Diocument: I LI

Diocument type: IUnspecifiedT_l,Jpe j Browse... |

Location:
(Typeddentien | S531ch test []
|Jzer tag: I

Lpskiz ekb ol pooRs || wed | Ewel |
current selection in:

ok I Cancel | Help | Apply |

3 Add a new Requirement 3 for the set of blocks that points to the text
“Tertiary Requirements” in the file requirement.doc.

Add the requirement as you would for a single block as described in
“Adding Requirement Links to an Object” on page 2-8.

Note When you add a requirement link to a block such as a subsystem, the
requirement is not added to children of the block.
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4 Click outside the three objects to deselect them.
5 Right-click the Engine block and select Requirements.

The Engine block now has three requirements, as shown.
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Doubla-click to Block Properties. ..
open the GUI Model Advisar..,
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it " ST oo
wpth 2. "Requirement 2" rehicle mph
Thr

R.eaI-Tlmx.a Worksrhop g 3. "Requirement 3" fyeliow)
Fixed-Paoint Settings... thmottle 9%

o Add link to Word selection E

U Bl Add link to active Excel cell

Mask Subsystem, .. Add link ko current DOORS object

Loak Under Mask Editfadd Links ...

Link @ptians 2 Link settings ...

Signal & Scope Manager. .. i | |0d35 4

6 Right-click the engine RPM and transmission blocks to verify that they
have only one requirement.

7 Save the model (my_sf_car).

Deleting All Requirement Links for Multiple Objects
Simultaneously

In “Adding Requirement Links to Multiple Objects Simultaneously” on page
2-17, you added requirement links to each block in a multiple selection of
blocks. To delete the existing requirements for a group of selected blocks,
right-click any of a group of selected blocks and, from the resulting context
menu, select Requirements > Delete All. Notice that this deletes all of the
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requirement links for all of the selected blocks, whether they were added
individually or as a group.

Selection-Based Linking

Selection-based linking is a quick way to make links between model elements
and selected portions of a requirements document, which can be a Microsoft
Word or Microsoft Excel file only. This method provides an ability to create
two-way links by embedding an ActiveX control into the requirements
document next to the selected string or cell.

The following tasks show you how to work with selection-based linking:

® “Opening the External Application” on page 2-20
* “Specifying Your Linking Preferences” on page 2-21
o “Making Selection-Based Links” on page 2-22

* “Navigating from the Requirements Document to the Simulink Model”
on page 2-25

Opening the External Application

Before creating selection-based links, you need to establish communication
between Simulink and the external application (Microsoft Word or Microsoft
Excel) by opening the application from within the Simulink. The document
you open cannot be read-only, or be already open in another application.

Note If you open a document some other way and try to create selection-based
links to it, Simulink displays an error message.

Use the following procedure to open a document for selection-based linking:
1 Open the model my_sf_car.

2 In Simulink, from the Tools menu, select Requirements > Link settings.
The Selection-based linking dialog box opens.
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Z)selection-based linking x|

Thiz capability enables linking to the active selection within an estermal
document and automates menu naming

I {wiord: I <No document seleched: | Browse |
v Excel I <Mo document selected: LI Browsze |
v DOORS I <Mo document selected: LI Browse |

Document file reference: I path relative to model directory j

v Modify documents to include links to models

Model file reference: I none [on MATLAE path] ;I

Another way to open the Selection-based linking dialog box is to right-click
on a Simulink block and, from the resulting pop-up menu, select
Requirements > Link settings.

3 From the drop-down list next to Word, select requirements.doc. Note that
the Browse button to the right of it changes to Open. Click the Open
button. The document requirements.doc opens in its editor, Microsoft
Word.

Note If you click Browse with no document selected, the Requirement
Management Interface lets you browse to the document of the appropriate
type to open it.

You can now make links between the blocks in the my_sf_car model and
portions of the requirements.doc document, as described in “Making
Selection-Based Links” on page 2-22.

Specifying Your Linking Preferences

In selection-based linking, the process of making links is streamlined
to minimize the number of menu clicks necessary to create a link. The
Selection-based linking dialog box lets you specify your preferences:
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® Two-way linking embeds an ActiveX control in your requirements
document, which lets you navigate from the requirements document to
the Simulink model. If you don’t want to create two-way links, clear the
Modify documents to include links to models check box.

¢ Use the Document file reference drop-down list to specify how to store
the document location. For more information on the choices available, see
“Resolving the Document Path” on page 2-15.

® Ifyou create two-way links, use the Model file reference drop-down list
to similarly specify how to resolve the model location when you navigate
from a requirements document to the Simulink model.

Making Selection-Based Links
Use the following procedure to create selection-based requirement links:

1 Open the requirements.doc document, as described in “Opening the
External Application” on page 2-20.

2 Select a portion of the text that documents the desired requirement.
For example, select a “Dummy text.” string, as shown in the following
illustration.
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3 In the Simulink diagram, right-click the Engine block and, from the
resulting pop-up menu, select Requirements > Add link to Word
selection.

The Requirement Management Interface creates the link. If you right-click
on the Engine block and select Requirements, the Engine block will now
have four requirement links, as shown. You can use this link to navigate
from the model to the requirements document, as described in “Viewing
Requirements Documents” on page 2-13.

2-23



2 Managing Model Requirements

2-24

File Edit WYiew Simulation Format Tools Help

| E@Iéﬁhﬁl ...... |} l|3 INormaI ”-m.@

sf_car.mdl

Uzar Inputs

E Brake
Throtte

Doubie-click to
open the GUI
and selectan

input manuever

thnottle

¥

R
Engi

Open Block r T

Choose Start from

Open Block In Mew Window

=]
Explore
Tout -
Cut put outpLt tongue

irnpedler ol
r sl the Simul ation menu
Ti to run the simulation.

Wehicle

requirements, doc@Simulink_requirement_item_1

Because your linking preferences are set to two-way linking, an ActiveX

Copy hrisrission

Delete trrsmission spesd

IMask Farameters, .

SubSystem Parameters, ..

Block Properties. ..

Model Advisor... weticle
=reer]

Requirements 1. "Requirement 1" hicke mph
2. "Requirement 2" e i)

Real-Time Warkshop thmttle %%

¥ X i 3. "Requirement 3"
Fixed-Paint Settings. ..

=

2D e Add link to Ward selection

Mask Subsystem, .. Add link to active Excel cel

4

control [: is embedded in the requirements document next to the selected
string, as shown in the next illustration. You can use it to navigate from

the requirements document to the model, as described in “Navigating from

the Requirements Document to the Simulink Model” on page 2-25.
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Note If you have the Requirements dialog box open, you can use the Word
and Excel buttons next to the Update fields with current selection in
label to create selection-based links to Microsoft Word or Microsoft Excel
requirements documents, respectively.

Navigating from the Requirements Document to the Simulink

Model

When you create two-way links, the Requirements Management Interface
embeds an ActiveX control in your requirements document next to the
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selected string or cell. This allows you to navigate from the requirements
document to the Simulink model.

1 Open the requirements.doc document in Microsoft Word.
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2 Click the ActiveX control embedded in the requirements document.

3 The Requirements Management Interface opens the model my_sf _car and
highlights the Engine block, as shown in the following illustration.
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The requirement item that is linked with the ActivX control is identified
internally with a special unique string that is saved in the model. If you
rename the item or change the path, the links in the external document will

continue to work.
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Linking to Custom Types of Requirements Documents

In addition to linking to built-in types of requirements documents described
above, you can register your own custom types of requirements documents
with the Requirements Management Interface, and then create requirement
links to these types of documents.

Why Create a Custom Link Type?

Custom link types let you define how a document will be opened and
navigated, and how you or another user can browse for a document and view
an index of its contents. When you define a custom link type, you create
MATLAB M-code functions that perform these operations. The Requirements
Management Interface invokes the registered code when navigating to a
document with the new link type, and when browsing for a document or
displaying the index of a document within the Requirements dialog box.

Using the external interfaces supported by MATLAB, you can communicate
with external applications and run programs from the command shell. You
can also use the built-in Web browser and text editor to display custom
variants of HTML and text files without loading external applications.

Custom link types enable you to

® Link to requirement items in commercial requirement tracking software
® Link to in-house database systems

® Link to document types that are not internally supported in the tool

Custom Link Type Registration

You register custom link types with a unique MATLAB function name. The
function must exist on the MATLAB path and must not require any input
arguments. It must return a single output argument that is an instance of
the requirements link type class. You can register your link type with the
following MATLAB command:

rmi register mytargetfilename

where mytargetfilename is the name of the MATLAB function contained in
the M-file named mytargetfilename.m.
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Once you register a link type, it appears as an entry in the Document type
drop-down list in the Requirements dialog box. The list of registered link
types is stored in a file in your preference directory, so it can be restored

in new MATLAB sessions. You can remove a link type with the following
MATLAB command:

rmi unregister mytargetfilename

When you create links using custom link types, the registration name is
saved in the model. When you attempt to navigate a link, the Requirements
Management Interface resolves the link type against the registered list and
displays an error message if the link type is not found.

Built-In Link Types

Built-in link types use the same format and naming convention as custom
types, although they use a different system for identification in the model file
that supports backwards and forwards compatibility. You can use the built-in
types as examples when developing your custom link types. The files for
built-in link types are contained in the private directory of the requirements
management tool (matlabroot\toolbox\simulink\regmgt\private):

linktype_rmi_doors.m
linktype_rmi_excel.m
linktype_rmi_html.m
linktype_rmi_pdf.m
linktype_rmi_text.m
linktype_rmi_word.m

Link Properties

Requirement links are the data structures, saved in the Simulink model,
that identify a specific location within a document. You can get and set the
links on a block using the rmi command. Link information is encapsulated
within a MATLAB structure array. Each element of the array is a single
requirement link.

Links and link types work together to perform navigation and manage
requirement interfaces. The document and ID fields of links uniquely identify
the linked item in an external document. The Requirements Management
Interface passes both of these string parameters to the navigation command of
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the associated link type when it follows a link from the model or a generated
report.

Link Type Properties

Link type properties define how links are created, identified, navigated and
stored within the requirement management tool. The following table explains
each of these properties.

Property Description

Registration | The name of the M-file that creates the link type. This is
stored in the Simulink model.

Label A string to identify this link type. It is displayed on the
Document Type drop-down list in the Requirements
dialog box for a Simulink or Stateflow object.

IsFile A Boolean property that indicates if the linked documents
are files within the computer file system. If a document is
a file, then the standard method for resolving the path is
used and the standard file selection dialog is invoked when
the user presses the Browse button in the Requirements
dialog box.

Extensions An array of file extensions. These are used as filter options
for the Browse button in the Requirements dialog box.
The extensions are also used to infer the link type based
on the document name. If more than one link type is
registered for the same file extension, the link type that
was registered first will take priority.

LocDelimiters | A string containing the list of supported navigation
delimiters. The first character in the ID of a requirement
specifies the type of identifier. For example, an identifier
might refer a specific page number (#4), a named bookmark
(emy_tag), or some text to search (?search_text). The
valid location delimiters determine the possible entries on
the Location drop-down list in the Requirements dialog
box.
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Property Description

NavigateFcn The MATLAB callback that is invoked when a user
follows a link. The function is evaluated with two input
arguments, the document field and the ID field of the link:

feval(LinkType.NavigateFcn, Link.document, Link.id)

ContentsFcn The MATLAB callback that is invoked when a user presses
Document Index tab in the Requirements dialog box.
This function is evaluated with a single input argument
containing the full path of the resolved function, or the
entry from the Document field if the link type is not a file.
The function should return three outputs:

e Labels

® Depths

e Locations

BrowseFcn The MATLAB callback that is invoked when a user presses
the Browse button in the Requirements dialog box. This
function is unnecessary when the link type is a file. The
function should not take any input arguments and should
return a single output argument identifying the document
that the user selected.

Creating a Custom Link Requirement Type

In this example, you implement a custom link type to a hypothetical document
format, which is a text file with the extension .abc. Within a document, the
requirement items are identified with a special text string Requirement::,
followed by a single space and then the requirement item inside double quotes
M".

You provide the ability to see a document index, containing a listing of all
the requirement items. When navigating from the Simulink model to the
requirements document, the document opens in the MATLAB editor and pans
the display to the line containing the desired requirement item.

Use the following procedure to create a custom link requirement type:
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1 Write a function that implements the custom link type and save it as an
M-file on MATLAB path. In this example, the file rmicustabcinterface.m,
containing the function rmicustabcinterface that implements the ABC

files,

is included in the installation. You can view it below, or by typing edit

rmicustabcinterface at the MATLAB prompt.

function 1linkType = rmicustabcinterface
%RMICUSTABCINTERFACE - Example custom requirement link type

0° 3% ° A% ° A° A% O° A% O° O° % O° O° O° O° o° oO°

o°

o°

o°

This file implements a requirements link type that maps

to "ABC" files.

You can use this link type to map a line or item within an ABC
file to a Simulink or Stateflow object.

You must register a custom requirement link type before using it.
Once registered, the link type will be reloaded in subsequent
sessions until you unregister it. The following commands
perform registration and registration removal.

Register command: >> rmi register rmicustabcinterface
Unregister command: >> rmi unregister rmicustabcinterface

There is an example document of this link type contained in the
requirement demo directory to determine the path to the document
invoke:

>> which demo_req_1.abc

Copyright 1984-2005 The MathWorks, Inc.
$Revision: 1.1.4.2 $ $Date: 2005/04/07 20:00:10 $

% Create a default (blank) requirement link type
linkType = RegMgr.LinkType;
linkType.Registration = mfilename;

% Label describing this link type

linkType.Label = 'ABC file (for demonstration)';

% File information
linkType.IsFile = 1;
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1linkType.Extensions = {'.abc'};

% Location delimiters
linkType.LocDelimiters = '>@';
linkType.Version = ''; % not needed

% Uncomment the functions that are implemented below
linkType.NavigateFcn = @NavigateFcn;
1linkType.ContentsFcn = @ContentsFcn;

function NavigateFcn(filename,locationStr)
if ~isempty(locationStr)
findId=0;
switch(locationStr(1))
case '>'
lineNum = str2num(locationStr(2:end));
openFileToLine(filename, lineNum);

case '@’
openFileToItem(filename,locationStr(2:end));
otherwise
openFileToLine(filename, 1);
end
end

function openFileToLine(fileName, lineNum)
if lineNum > 0
err = javachk('mwt', 'The MATLAB Editor');
if isempty(err)
editor = com.mathworks.mlservices.MLEditorServices;
editor.openDocumentToLine(fileName, lineNum);
end
else
edit(fileName);
end

function openFileToItem(fileName, itemName)
reqStr = ['Requirement:: "' itemName '"'];
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lineNum = 0;
fid = fopen(fileName);
i =1;
while lineNum ==
lineStr = fgetl(fid);
if ~isempty(strfind(lineStr, reqStr))
lineNum = 1i;
end;
if ~ischar(lineStr), break, end;
i=1+1;
end;
fclose(fid);
openFileToLine(fileName, lineNum);

function [labels, depths, locations] = ContentsFcn(filePath)
% Read the entire M-file into a variable
fid = fopen(filePath,'r');
contents = char(fread(fid)');
fclose(fid);

% Find all the requirement items
fList1 = regexpi(contents, '\nRequirement:: "(.*?)"','tokens');

% Combine and sort the list
items [fList1{:}]";

items = sort(items);

items strcat('@',items);

if (~iscell(items) && length(items)>0)
locations = {items};
labels = {items};
else
locations = [items];
labels = [items];
end

depths = [1;
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2 To register the custom link type ABC, type the following MATLAB
command:

rmi register rmicustabcinterface

This will cause the ABC file type to be added to the drop-down list of
document types in the Requirements dialog box.

3 Create a text file with the .abc extension, containing several
requirement items marked by the Requirement:: string, as described
above. For your convenience, an example of such a file is included
in the installation. It is named demo_req_1.abc, and is located in
matlabroot\toolbox\simulink\regmgt\rmidemos. The contents of this
file is displayed below.

Requirement:: "Altitude Climb Control"

Altitude climb control is entered whenever:
|Actual Altitude- Desired Altitude | > 1500

Units:
Actual Altitude - feet
Desired Altitude - feet

Description:

When the autopilot is in altitude climb
control mode, the controller maintains a
constant user-selectable target climb rate.

The user-selectable climb rate is always a
positive number if the current altitude is
above the target altitude. The actual target
climb rate is the negative of the user
setting.

<END "Altitude Climb Control">
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Requirement:: "Altitude Hold"

Altitude hold mode is entered whenever:
|Actual Altitude- Desired Altitude | <
30*Sample Period*(Pilot Climb Rate / 60)

Units:

Actual Altitude - feet

Desired Altitude - feet

Sample Period - seconds

Pilot Climb Rate - feet/minute
Description:

The transition from climb mode to altitude
hold is based on a threshold that is
proportional to the Pilot Climb Rate.

At higher climb rates the transition occurs
sooner to prevent excessive overshoot.

<END "Altitude Hold">

Requirement:: "Autopilot Disable"

Altitude hold control and altitude climb
control are disabled when autopilot enable
is false.

Description:

Both control modes of the autopilot
can be disabled with a pilot setting.

<END "Autopilot Disable">
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Requirement:: "Glide Slope Armed"

Glide Slope Control is armed when Glide
Slope Enable and Glide Slope Signal
are both true.

Units:
Glide Slope Enable - Logical
Glide Slope Signal - Logical

Description:

ILS Glide Slope Control of altitude is only

enabled when the pilot has enabled this mode

and the Glide Slope Signal is true. This indicates
the Glide Slope broadcast signal has been

validated by the on board receiver.

<END "Glide Slope Armed">

Requirement:: "Glide Slope Coupled"

Glide Slope control becomes coupled when the control
is armed and (Glide Slope Angle Error > 0) and
Distance < 10000

Units:

Glide Slope Angle Error - Logical

Distance - feet

Description:

When the autopilot is in altitude climb control
mode the controller maintains a constant user

selectable target climb rate.

The user-selectable climb rate is always a positive
number if the current altitude is above the target
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4 Open the model my sf _car.

5 Right-click the Engine block and, from the resulting pop-up menu, select

altitude the actual target climb rate is the

negative of the user setting.

<END "Glide Slope Coupled">

Requirements > Edit/Add Links.

The Requirements dialog box appears.

6 Click New to add a new default requirement. Note that ABC file type is
now available in the Document Type drop-down list, as shown.

E! Requirements: Engine ll
Requirements I Diocument Index |
New Hequ?rement 1
Requirement 2
Copy | Requirement 3
Duranag test.
Delete | <Muo dezcription entered:
v
Down |
Dezcription: |<Nn description entered:
Diocument: I LI

Diocument Type: I

Location:
[Typedidentifier)

Tag:

|Jpdate fields with
current selection i

Unzpecified Type

Tewt file

HTHL file:
ticrosoft word
ticrosoft Eucel
POF documents
DOORS Item
wéeh Browser LIRL

Browse...
R

Eucel |

[

ABC file [for demonstration]
I

| Apply

7 Set Document Type to ABC file (for demonstration) and browse to
the demo_req_1.abc file, or to your own .abc requirements file that you
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created in Step 3. Note that the browser shows only the files with the
.abc extension.

8 Define a particular location in the document. In this example, you can
either use a line number or a requirement name as the item identifier, so
the location delimiters in the rmicustabcinterface function are specified
as >@. As a result of this parameter, the Location drop-down menu
contains these two items whenever the document type is set to ABC file, as
shown.

E! Requirements: Engine ll

Requirements IDocumEandBH |

New Hequ?rement 1
Requirement 2
Copy | Requirement 3
Duranag test.
Delete | <Muo dezcription entered:
v
Down |
Dezcription: |<Nn description entered:
Diocument: I Dvifork s D v custann_requirements. abc LI

Diocument Type: IABE file [for demonztration) j Browsze... |

Location: -

(Typeddentfier) |1 \3med item |
) Line number

—

ag:

|Jpdate fields with
current selection in:

ok I Cancel | Help | Apply |

DOaRs | whard | Eucel |

Creating a Document Index

The example file format clearly defines requirement items that are easily
listed. To generate a document index, set the ContentsFcn to a valid function.
The MATLAB code uses file I/O to read the contents into the MATLAB
variable. The Requirements Management Interface uses the regular
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expression utility in MATLAB to extract a list of requirement items that it
returns.

The following code generates an index for the ABC files.

function [labels, depths, locations] = ContentsFcn(filePath)
% Read the entire M-file into a variable
fid = fopen(filePath,'r');
contents = char(fread(fid)');
fclose(fid);

% Find all the functions
fList1 = regexpi(contents, '\nRequirement:: "(.*?)"','tokens');

% Combine and sort the list
items [fList1{:}]";

items sort(items);

items = strcat('@',items);

locations = [items];
labels = [items];
depths = [1;

For example, for the demo_req_1.abc file discussed earlier in “Creating a
Custom Link Requirement Type” on page 2-31, this function generates the
document index as shown in the following illustration.
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E! Requirements: Engine ll

Reguirements | Document Index | 1=

Content of demo_req_1.abc

Double click to update fields with selected item

@aitude Hold

@Autopilot Dizable

@Glide Slope Armed %
@Glide Slope Coupled

4] | L|j
ok I Cancel | Help | Apply |

Navigating to Simulink from External Documents

The Requirements Management Interface includes several functions that
simplify creating navigation interfaces in external documents. The external
application that displays your document must support an application program
interface (API) for communicating with MATLAB.

Providing Unique Obiject Identifiers

Whenever you create a requirement link for an object in Simulink or Stateflow,
a globally unique identifier is created for that object. This identifier is used to
identify the object and will not change if the object is renamed or moved or
when requirement links are added or deleted. Although the unique identifier
is only used to resolve an object within a model, the identifier is globally
unique and should not collide with identifiers in other models unless the two
models derive from the same original model. Unique object identifiers have
formats like GIDa_cd14afcd_7640 4ff8 9ca6_14904bdf2f0f.
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Using the rmiobjnavigate Utility

The rmiobjnavigate function performs the required actions to identify the
appropriate Simulink or Stateflow object, highlight that object, and bring the
appropriate editor window to the front of the screen. When you navigate to
Simulink from an external application, invoke this command. Internally this
function creates a table of all the unique object identifiers within a model,
which is used for efficient object lookup.

The first time you navigate to an item in a particular model, there may be a
slight delay while the internal navigation table is constructed. Subsequent
navigation should have minimal delay.

Determining the Navigation Command

Once you have created a requirement link for a Simulink or Stateflow object,
you can find the appropriate navigation command string using the rmi
function in MATLAB. The return value of the navCmd method is a string that
navigates to the correct object when evaluated in MATLAB:

cmdString = rmi('navCmd', block);

You need to send this exact string to MATLAB for evaluation as part of
navigating from the external application to Simulink.

Using the ActiveX Navigation Control

A special ActiveX control is included with Simulink Verification and Validation
and is used to enable linking to Simulink models from Microsoft Word and
Microsoft Excel documents. You can use this same control from any other
application that supports ActiveX within its documents.

The control is derived from a pushbutton and has the Simulink icon.
There are two instance properties that define how the control works. The
tooltipstring property is the string that is displayed in the ToolTip of the
control. The MLEvalCmd property is the string that is passed to MATLAB for
evaluation when the control is pushed.
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Typical Code Sequence for Establishing Two-Way Links

When you create an interface to an external tool, the procedure for
establishing links can often be automated so that no dialog fields need to be
manually updated. This type of automation is part of the selection-based
linking that is implemented for certain built-in types, such as Microsoft Word
and Microsoft Excel.

In generic terms, use the following process:

1 Select an object in Simulink or Stateflow and an item in the external
document.

2 Invoke the link creation action either from a menu or command in
Simulink, or a similar mechanism in the external application.

3 Identify the document and current item using the scripting capability of the
external tool. Pass this information to MATLAB and create a requirement
link on the selected object using rmi('createempty') and rmi('cat').

4 Determine the MATLAB navigation command string that must be
embedded in the external tool using the navCmd method:

cmdString = rmi('navCmd',obj)
5 Create a navigation item in the external document using the scripting
capability of the external tool and set the MATLAB navigation command
string in the appropriate property.

You can use the code for selection-based linking to Word, Excel, and DOORS
as an example of this type of automation. The files are contained in
matlabroot\toolbox\simulink\reqmgt\private:

selection_link_doors.m
selection_link_excel.m
selection_link_word.m
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Viewing Objects with Requirement Links

After you have added requirements to blocks in a model, you can change
the view in the Model Explorer window to show only objects that have
requirements associated with them. In “Adding Requirement Links to an
Object” on page 2-8 and “Adding Requirement Links to Multiple Objects
Simultaneously” on page 2-17, you add requirements to the Engine, Engine
RPM, and transmission blocks in the model you save as my sf _car. Use the
following procedure to highlight these objects in the Model Explorer and
Simulink:

1 Open the model my_sf_car.
2 In Simulink, from the View menu, select Model Explorer.

3 The model and its elements appear in the Model Explorer window as shown.

5 Model Explorer I [ 5]
File Edit Wew Tools Add Help
[DEimmx EM<%H70 @Dm 4k [xa=al
”Sear:h. |t Block Type | Tvpe [Gain =| [Zf Search
Madel Hiesarchy | IEnntanls of: my_sf_car Model Properties
-] Simuiink Fioot [Hame || Main | Calbacks | History | Desorpton | =2
----ﬁBaseWulksDace Ty chift logic n
- 5 Model Watkspace Model Information for: my sf car
H HMDdEIkasDace % Configuration [Active) Source file:  [\WorksModels\regmathmy sf carmdl
.%Cunhgurallun [ictive] ? Selvics for my_sf_car Last Saved: ThuApr 01 15:06:55 2004
- b Code for my_sf_car &b Cods far my s'f C'a' Created On:  Tue Jun 02 16:12:01 1932
® Advice for my_st_car |® stun o Is Modified: e
Q-IEngme =1 Musx Model Version: 1.74
--&IThreshold Calculation =] engine RPM
ﬁ_&]l_lser\npuls I=1 vehicle mph [vellow) & throttle %
Hvehicks 72 Vehicle
+ zhift_logic E Engine
L@Itransm\ssinn E \ransmission
ﬂ User Inputs
E Threshald Caleulation _'LI
o | oA [FE
Contents I Search Results Revert | Help | Apply |
VA

4 In the Model Explorer toolbar, select the Display Objects with Linked

Requirements tool .
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& Model Explorer =10l x|
File Edit Wew Tools Add Help

Dz s mmx M%7 0 om+r|Fxazd
”Sear:h. |bw Block Type | Tvpe [Gain =l Search

Wodel Hierarchy Contents of. my_sf_car Model Properties
- EH]Simlink Roct [Wome [ ApplToilibs |Trea | Méi | Colbacks | History | Description | 2
----ﬁBaseWulksDace BR [m]
gine - .
Ry sf_car %mmm O Model Information for: my sf car
1 engine APM Source file:  [:vWork\Modelshregmgtimy sf carmd]

Last Saved: Thufpr 01 14:21:06 2004
Created On:  Tue.Jun 02 16:12:01 13538
Is Modified: no

Model Version: 1.73

4l | L |_>|;I

Contents I Search Resuls Bevert | Help | Lpply |

5 To see all objects, click the Display Objects with Linked Requirements tool
again to deselect it.

You can also highlight blocks of a Simulink model with associated
requirements in a Simulink model window as follows:

1 In the Model Explorer toolbar, select the Highlight Items with
Requirements in Model tool .
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Highlighted blocks have requirements

=10l x|

File Edit Wiew Simulation Format Tools Help
Dlﬁﬂ@l%ﬁl:&ﬂl/‘ m o fromal jl@

sf_car.mdl é — {mu& | Choose Start from
L’ * the Simul ation menu
T to run the sivncd ation.

REB T ®

b —— il W
o] throttle engindfHF
2=
Engine e
-
L P
Usar Inputs — Vetide
trRnsmission
E Brke ——
traremizsion speed
Throttle
Doubie-click to
open the GUY
. and sedect an wticle
nput maneuver spesd
wehizle mph
fyzllow)
Threshod Cakulation & thmttle %
o |
L
-
|
Ready [1o02 [ [ lodes v

2 To drop the highlighting, click the Highlight Items with Requirements
in Model tool again to deselect it.
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Generating a Requirements Report

After you have added requirements to a model, you can generate a report on
all the requirements associated with the model and its blocks. In “Adding
Requirement Links to an Object” on page 2-8 and “Adding Requirement Links
to Multiple Objects Simultaneously” on page 2-17, you add requirements to
the Engine, Engine RPM, and transmission blocks in the model you save as
my_sf_car. Use the following procedure to generate a requirements report:

1 Open the model my_sf_car.

2 In Simulink, from the Tools menu, select Requirements > Generate
Report.

The Requirements Management Interface searches through all the blocks
and subsystems in the model for associated requirements, generates a
complete report in HTML format with the default name rmi.html, and
displays it in your system Web browser, as shown.
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[Bodel Requrements - Microsat Itemet Evplrer i
J Fle Edt View Favorites Tools Help | l’;'

J L_)Back - \j\ = Ij li"l '\J|/":sEarch \j:(Favnntes -€‘}| 3~ ;7 ] - J ﬂ 3

| Address [& o:\workywonwyrmi bl B
|Links ] Customize Links @] FAQPage €] Free Hotmall (€] Help Page »|| @ snagt 1 H & -

-

Model Requirements
jsmith

17-Feb-2005 15:14:53

Table of Contents

1. System - Engme

2. Zystem - transmission
3. Block - engine BPW

Chapter 1. System - Engine

fhictila

angina + impaller

forqua inariia

Description| Document D

Requirement requirements. doc Primary
1 Reguirements

Reguirement requirements. doc|Secondary
2 Eequitements

Requirement requirements. doc | Tertiary
3 Eequirements

Chapter 2. System - transmission

Tarqua gear Tl
- Comvartar L

= nars';r:;sinn
(€D
Mot
=l
EE== BN T —

3 To save the report with a meaningful name, in the Web browser main menu
click File > Save As, type the desired filename, and click Save.
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Displaying the System Requirements in a Diagram

You can list all the requirements for a model or a subsystem directly on the

Simulink diagram. You do this by adding the System Requirements block from
the Simulink Verification and Validation library to the diagram. You can place
this block anywhere in a diagram. It is not connected to other Simulink blocks.

Once you place the System Requirements block in a Simulink diagram, it
automatically lists the requirements associated with the model or subsystem
depicted in the current diagram. It does not list requirements associated
with individual blocks in the diagram.

The following topics show you how use the System Requirements block:

® “Adding the System Requirements Block” on page 2-49 — Describes how
to display a listing of system requirements in a diagram by adding the
System Requirements block

* “Renaming the System Requirements Block” on page 2-52 — Describes how
to change the heading of the listing of system requirements in a diagram

® “Changing Fonts for the System Requirements Block” on page 2-53 —
Describes how to change the font size or style for the listing of system
requirements in a diagram

Adding the System Requirements Block

In “Adding Requirement Links to an Object” on page 2-8, you added
requirement links to the Engine block of the model my_sf_car. You can list
these requirements in the block diagram of the Engine subsystem as follows:

1 Open the model my_sf_car.

2 Double-click on the Engine block. The Engine subsystem diagram opens, as
shown.
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E!my_sf_car,.-"Engine L _I- _ID ll
File Edit WYiew Simulation Format Tools Help
DSE&| 2R < » =0 [Momal =] O3 & 21 & 2 | B
Ti
= D
thmttle i s j— e
engine engine + impelier
toque ineriz.
Ready [1o02 [ [ |odes v

3 Click the Library Browser tool e .
The Simulink Library browser opens.

4 In the left pane of the Simulink Library browser, select Simulink
Verification and Validation.

The Simulink Verification and Validation library opens in the right pane of
the Simulink Library browser. It contains one block, System Requirements.

5 Select the System Requirements block in the right pane of the Simulink
Library browser and drag it to an empty space in the Engine diagram.

The block is automatically populated with the system requirements for the
Engine diagram, as shown.
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File  Edit

=10l x|

Wiews Simulation Format  Tools  Help

DSE&| $BE| < » o |tomd || Bis [ S|

engine

engine + impelier

Ready

omue

ine iz

Syatern Reguirementa
1. ‘Requirerment 1*
2. "Requirement 2*

3. "Reguirement 3°

[1o02

|odes

4

6 Each of the listed requirements is an active link to the actual requirements
document. For example, to access the document for the second requirement

link, double-click on 2. Requirement 2.

The document requirements.doc opens in its editor, Microsoft Word,
scrolled to the highlighted first occurrence of the text “Secondary
Requirements,” as shown.

=Bl x|

equirements.doc {Read-Only} - Microsoft Word

File:

NEHARSRY sRBC -« - |aAOD
- show | &8y O - | a-

Final Showing Markup

Edit
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H
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E ==

Help

4 | B 125%
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- X

2
[elmg -
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= OB M) &

U

- 1 [
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Once the System Requirements block is placed in a diagram, it automatically
updates the listing as you add, modify, or delete requirements for the model
or subsystem.

Note The System Requirements block automatically lists all the system
requirements for the current model or subsystem. You cannot have more than
one System Requirements block in a diagram.

Renaming the System Requirements Block

By default, the list of the system requirements in a diagram appears under a
heading System Requirements. You can change the heading by renaming the
System Requirements block in the diagram, as follows:

1 Right-click on the System Requirements block in the my_sf_car/Engine
diagram.

2 From the resulting pop-up menu, select Mask Parameters. The Block
Parameters dialog box opens, as shown.

E Block Parameters: System Requirements x|

— Spstem Requirements [mazk)

Lizts the requirements for the current model.

—Parameters

Block, Title

Systemn Fequirements L

Ok I Cancel | Help | Apply |

3 Type Engine Requirements in the Block Title field and click OK.

The requirements heading in the diagram is updated as shown.
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E!my_sf_car,.-"Engine L _I- _ID ll

File Edit WYiew Simulation Format Tools Help

Ti
- D
thmttle i s !
e

engine engine + impelier
tomue inertiz,

Engine Requirements
1. ‘Requirerment 1*
2. "Requirement 2*

3. "Reguirement 3°

Ready [1o02 [ [ |odes v

Changing Fonts for the System Requirements Block

The System Requirements block is implemented using a set of empty
subsystems. Because of this, occasionally the appearance is not refreshed
correctly, for example, when you make a change to the font style or size. You
can easily fix this problem by double-clicking the top label for the block, which
causes the entire block display to refresh.

Use the following procedure to change the font used in the block.

1 Right-click on the System Requirements block in the my_sf_car/Engine
diagram.

2 From the resulting pop-up menu, select Format > Font. The Set Font
dialog box opens.

3 Under Size, select 14, then click OK. The block display partially refreshes,
as shown.
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E!my_sf_car,.-"Engine &5
File Edit WYiew Simulation Format Tools Help

D2E&| $BR|< | r s |iomd < Hi @S

engine engine + impelier
tomue inertiz,

System Pequirements
1. ‘Requirerment 1*
2. "Requirement 2*
3. "Reguirement 3°

Ready 100%: odeS
4

4 To refresh the entire block display, double-click the top label, System
Requirements. The block diagram now looks as shown below.

E!my_sf_car,.-"Engine &5
File Edit WYiew Simulation Format Tools Help

D2E&| $BR|< | r s |iomd < Hi @S

engine engine + impelier
tomue inertiz,

System Requirements
1. "Raquirement 1"
2. "Requirement 2"
3. "Requirement 3"

Ready [1o02 |odes v
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Including Requirements with Generated Code

Once you finish simulating your model and verifying its performance against
the requirements, you might want to use it to generate code for an embedded
real-time application. Simulink includes the requirements that you assign to
Simulink blocks in generated code for Embedded Real-Time (ERT) targets of
Real-Time Workshop® Embedded Coder.

To specify that requirements be included in the generated code of an ERT
target, do the following:

1 Load the model.

2 In the Simulink window, from the Simulation menu item, select
Configuration Parameters.

3 In the Select pane of the Configuration Parameters dialog box, select the
Real-Time Workshop node.

The currently configured system target must be an ERT target, as shown.
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E! Configuration Parameters: my_vdp/Configuration

RTW confiqured for ERT farget

Select: —Target selection

.. Data Flacement [ lgnare custom storage classes

Sohver System target file:lelt.llc Browse... |
- Data Import/Export
- Dptimization Language: I [ LI
- Diagnostics Desciiption: Real-Time “Waorkzhop Embedded Coder [no auto configuration]
- Sample Time
- [ ata |ntedrity —Documentation
- Conversion [~ Generate HTML repoit
- Connectivity X
.- Compatibiliy I~ Include hyperinks to mods]
- Model Referencing I~ | Launch report after code generation completes
- Hardware Implemertatio n
- Model Referencing —Build proc:
=1-Real-Time Woikshoj .
= B TLC aptions: |
Comments
Symbols I ake commnand: Imake_rtw
- Custom Code Template makefile:Ierl_default_lmf
- Debug
- Interface —Custom storage class
- Templates

™ Generate code only

Cancel

Help

Euild

Apply

=l
I

4 In the Select pane, under Real-Time Workshop, select Comments.

5 In the Custom comments section on the right, select Requirements in

block comments, as shown.
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E! Configuration Parameters: my_vdp/Configuration

Select:

Sobeer
- Diata Import/E spart
- (ptimization
[=I-Diagnostics
- 5 ample Time
- Data Integrity
-~ Conversion
- Cannectivity
- Campatibility
Model Referencing
ardw are Implementation
odel Referencing
[=]-Real-Time ‘wWiorkshop
- Comments
- G umbiols
- Customn Code
- Diebug
- |berface
- Templates
- Data Placement

=T

—Dwerall control

¥ Include commerts

—a&uto generated comment:
W Simulink block comments
W Show gliminated statements

I~ Werbose comments for SimulinkGlobal storage class

—Custom comments

I~ Simulink block descriptions [~ Stateflow ohiect descriptions

[~ Simulink data objsct descriptions V' Requiements in block comme nts
I Custorn commerts [MPT obiscts only)

oK Cancel

Include requirements descriptions
in generated code comments

Requirement descriptions are included with generated code in the following

locations.

Model Element

Requirement Description Location

Model

In the main header file <model>.h

Nonvirtual subsystems | At the call site for the subsystem

Virtual subsystems

<model>.h.

At the call site of the closest nonvirtual parent
subsystem. If a virtual subsystem has no

nonvirtual parent, requirement descriptions are
located in the main header file for the model,

Nonsubsystem blocks In the generated code for the block
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Managing Model
Requirements with DOORS

The Requirements Management Interface for DOORS associates DOORS
requirements with model objects. To learn how to use these applications

together, see the following sections:

“What Is the Requirements
Management Interface for DOORS?”
(p. 3-2)

“Configuring the Requirements
Management Interface for DOORS”
(p. 3-3)

“Starting the Requirements
Management Interface for DOORS”
(p. 3-5)

“Linking Objects to DOORS
Requirements” (p. 3-7)

“Synchronizing DOORS with the
Simulink Model” (p. 3-12)

“Navigating Between Model Objects
and DOORS” (p. 3-24)

Shows how the Requirements
Management Interface associates
objects with DOORS requirements

Specifies additional files from
MATLAB that you need to copy into
your installation for DOORS

Describes how to start the
Requirements Management
Interface for DOORS and create
projects

Describes how to add two-way links
between Simulink or Stateflow
objects and DOORS requirements

Describes how to synchronize the
model and link synchronized objects
with DOORS requirements

Describes how to move between the
model and the DOORS synchronized
module, and how to view the nodes
in an object that have associated
requirements
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What Is the Requirements Management Interface for
DOORS?

DOORS is a requirements management application that captures, tracks, and
manages user requirements. The Requirements Management Interface for
DOORS is a special interface between your Simulink model and DOORS.



Configuring the Requirements Management Inferface for DOORS

Configuring the Requirements Management Interface for
DOORS

DOORS is a requirements management application for capturing,
tracking, and managing requirements. If you plan to use DOORS with
the Requirements Management Interface for DOORS, you must install
some additional files to establish communication between DOORS and the
Requirements Management Interface for DOORS:

e If DOORS is installed at the time you install the Requirements
Management Interface and run the setup script, as described in
“Configuring the Requirements Management Interface” on page 2-4,
no additional installation for DOORS is necessary. The setup script
automatically copies all the necessary files to the correct location.

¢ Ifyou install DOORS after you install the Requirements Management
Interface, or if you upgrade the DOORS installation at a later date, run the
setup script again. To do this, in the MATLAB Command Window type

rmi setup

Manual Installation for DOORS

Normally, the setup script automatically copies all the files to the correct
location. However, in some cases the script might fail because of file
permissions in your DOORS installation. If this happens, you have to
manually install additional files, as described in the following procedure:

1 If DOORS is running, close DOORS.

2 Copy the following files from matlabroot\toolbox\simulink\reqmgt to the
<doors>\1lib\dxl\addins directory:

addins.idx
addins.hlp

<doors> represents the top-level directory where DOORS is installed.
Replace any existing versions of the files if they have not been modified;
otherwise, merge their contents.
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3 Copy the following files from matlabroot\toolbox\simulink\reqmgt to the
<doors>\1lib\dx1l\addins\dmi directory.

dmi.hlp
dmi.idx
dmi.inc
runsim.dxl
selblk.dxl

Replace any existing versions of these files.

4 Open the file <doors>\1ib\dx1l\startup.dxl, and add the following
include statement in the user-defined files section:

#include <addins/dmi/dmi.inc>



Starting the Requirements Management Interface for DOORS

Starting the Requirements Management Interface for

DOORS

Use this procedure to start the Requirements Management Interface for

DOORS. Do this prior to synchronizing the model with DOORS and linking
objects to DOORS requirements.

1 Start MATLAB in DOS or UNIX with the following command:

\...\matlab.exe /automation

MATLAB starts up minimized with a default matlabroot\bin path. This
mode of operation is necessary to navigate between an object mapping
in DOORS and its source object in the Simulink model. If this type of
navigation is not needed, open MATLAB in default mode.

2 Start DOORS.

The DOORS Database window appears, as shown.

| DOORS Database: / - DDORS

=10l x|
File Edit Yiew Favorites Tools Help
eGP (28 o=
Favorites: I j Location: I j
Marme | Type | Descripkion
1 | i
’_|Username: Administrator |User bype: Administrator | v

You must have a project open in DOORS in order to use the MATLAB
Requirements Management Interface. If you do not have a project to open,
create and open one as follows:

1 Right-click the DOORS Database node in the left pane and, from the
resulting menu, select New > Project.
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The New Project dialog box appears, as shown.

| New Project - DOORS x|

M ame: I Imm

Drescription: |

QK I Cancel | Help |

2 Enter the name Test Project and the description This is a test
project. and click OK.

The new project appears in the right pane of the dialog box, as shown.

| DOORS Database: / - DDORS

_|ol x|
File Edit Yiew Favorites Tools Help
|EEmEs 8y P|%2 2|
Favarites: I j Location: I j
Marme | Type | Descripkion
Test Project Project This is a test project,
1 | i
l_ |Username: Administrator

|User bype: Administrator |

3 In the right pane, double-click the project to open it. The projects opens, as
shown.

| DOORS Database: /Test Project - DOORS

_|ol x|

File Edit Yiew Favorites Tools Help

Weall NN al® <= A= PENE N6 o

Favorites: I j Location: I.-"Test Project j

ﬂ DOORS Database Marme | Type | Descripkion

..435) Test Project
1 | i

’_|Username: Administrator |User bype: Administrator v
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Linking Objects to DOORS Requirements

The Requirements Management Interface for DOORS lets you add links to
DOORS requirements directly to the Simulink or Stateflow objects, without
having to synchronize the model and navigate to the surrogate DOORS
module. This linking mechanism is similar to selection-based linking to
Microsoft Word and Microsoft Excel documents, described in “Selection-Based
Linking” on page 2-20. It also creates two-way links by creating a special
navigation object in DOORS, which allows you to navigate from the DOORS
requirement to the associated object in the Simulink or Stateflow diagram.

The following topics describe how to link a Simulink or Stateflow object to a
DOORS requirement:

® “Creating a DOORS Requirement Object” on page 3-7 — If you are not
familiar with DOORS, use this procedure to create requirement items in a
formal module.

® “Linking a Simulink or Stateflow Object to a DOORS Requirement” on page
3-9 — Use this procedure to link an object to a DOORS requirement.

Creating a DOORS Requirement Object

Use the following procedure to create a DOORS requirement object in a
formal module.

1 In the main DOORS window, from the File menu, select New > Formal
Module to create a new formal module.

The New Formal Module dialog box appears, as shown.
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| New Formal Module - DIZIIII';. x|
Mame: M—
Drescription: |
— Object [dentifier

Start at: |1 Prefix: I

— Template
[ Use atemplate
I Browse,.. |

QK I Cancel | Help |

2 In the Name text field, enter the name Requirements and click OK.

The new formal module Requirements appears listed in the DOORS main
window. A window for Requirements is already open, but not in focus.

3 In the main DOORS window, double-click the Requirements module to
bring it in focus.

4 In the formal module window Requirements, from the Insert menu select
Object.

A new object appears in the formal module, as shown.

I Formal module */Test Project/Requirements’ current 0.0 - DO! -0l x|

File Edit Yiew Insert Link Analysis Table Tools User MATLAE Help

273

HEE| L 2BR|¥|X v |58 2 U &= = BB == |
||Standardview j“nlllevels j|:\'-: ::@:ﬁ| = |’¥{€ B %l|ﬂ|ﬁW|

[+ Requirements D | ;I

. | _>|LI
4

|Username: Administratar |Exc|ys/ive edit mode

New object in Requirements module
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5 Right-click the object in the right pane and, from the resulting context
menu, select Properties.

6 In the resulting Object properties dialog box, enter the Heading
Transmission Requirements, some text for Object Text, and select OK.

You should now see an object similar to the following in the Requirements
formal module.

I Formal module */Test Project/Requirements’ current =10] x|
File Edit WYiew Insert Link Analysis Table Tools User MATLAE Help

CEEIRE LI == EEE (D

|Standard i ﬂ |AII levels j Sac Ak {E @ 5 %l Le | @ EF

—|- Reqguirements D | J

1 Transmission Requirements: St 1 = = =
1 Transmission Requirements
Zhould have five gears: Park, Reverse, D1, D2, and Lo. User cannot start
engaged.Feverse cannot be entered from D1 unless the vehicle is not mao
D2 unless the speed of the vehicle iz less than 15 mph.

KU — Y / »H

Username: Administratar Exclusive/eﬁ mode

Specified object in Requirements module

Linking a Simulink or Stateflow Object to a DOORS
Requirement

In “Creating a DOORS Requirement Object” on page 3-7, you created a
Transmission Requirements object in the Requirements formal module in
DOORS. Now use the following procedure to link the transmission block in
the sf_car model to this DOORS requirement.

1 In the MATLAB Command Window, type sf_car at the MATLAB prompt to
open the demo model sf_car.mdl.

2 In the formal module window Requirements, select the Transmission
Requirement node in the left pane, as shown.
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| Formal module /My Test Praject/Requirements’ current 0.0 - DDORS -|of x|

File Edit View Insert Link Analysis Table Tools User MATLAB Help

|H|@ e % BR[| % X v [=t=B £ sz E: % |
[stsndard view | fartevels ]| e 2 o2 [ = =BT B
= Requirements o [ e

~1 Transmission Requirements: St — =
t 1 Transmission Requirements

Should have five gears: Fark, Reverse, D1, D2, and Lo. User cannot start
engine unless the Park gear is engaged Rewverse cannot be entered from D1
unless the wehicle is not moving. Lo cannot be entered from D2 unless the
speed of the wehicle is less than 15 mph

. ke D
A

|Username: Administrator |Exchusive edi mode

3 In the Simulink diagram, right-click on the transmission block and, from
the resulting pop-up menu, select Requirements > Add link to current
DOORS object.

The Requirements Management Interface for DOORS adds the link to the
DOORS requirement object, as shown.

| Formal module /My Test Praject/Requirements’ current 0.0 - DDORS -|of x|
File Edt View Insert Link Analysis Table Tools User MATLAB Help

H@e] % BR[| X v [=t=B £ U s

B =

[stsndard view | [Ftevels =] e o o2 | = " 3w
= Requirements D | i =
[=)- 1 Transmission Requirements: St T n A m L
B i intcioonae e 1 Transmission Requirements

Should have five gears: Fark, Reverse, D1, D2, and Lo. User cannot start
engine unless the Park gear is engaged Rewverse cannot be entered from D1
unless the wehicle is not moving. Lo cannot be entered from D2 unless the
speed of the wehicle is less than 15 mph

2 |(Simulins reference: sf_carsransmission (SubSysten)) L

-

T — 3 Zh
|Username: Administrator |Exchusive edi mode 7

4 Save the DOORS module.

5 Save the Simulink model as sf_car_doors.mdl.

The Requirements Management Interface uses the DOORS absolute number
and the unique module number to identify items in DOORS. This ensures
that the correct item is identified even if the module is renamed or the items
in the module are rearranged.
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You can also use the Requirements dialog box to create links to DOORS
objects. Set the Document type field to DOORS Item and click Browse. The
Requirements Management Interface opens the DOORS database. Browse to
the desired module and specify the DOORS item number.

3-11



3 Managing Model Requirements with DOORS

Synchronizing DOORS with the Simulink Model

This section shows you how to create the synchronized module and link
objects with DOORS requirements in the following topics:

® “Synchronizing a Model with DOORS” on page 3-13 — Describes why
synchronization is needed, when to synchronize, and how to synchronize

¢ “Linking Requirements to the DOORS Synchronized Module” on page 3-22
— Describes how to link synchronized objects with DOORS requirements

Keep in mind the following synchronization rules:

® Synchronization is optional

® You can create requirement links before or after you synchronize, in any
order

® The synchronized module captures requirement information from the
model into the DOORS database, enabling further analysis and reporting

The following diagram illustrates the synchronization process.
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Objects in a Simuink Medd

DOORS Synchronized Module

Obiject ID Block Hame

200 1 i odel

03 1] Subsystern

01 1.11  Blod

04 112 Blodk

205 113 Block

04 1.2 Subsystern
DOOES Formml oduss) ith Bqirsmsnt i L2 ot

. " - Each object in aimulink model is mappedta an

g] ject ID I]!eqmremeni. abject with a unique [0 in a DOORS formal module
07 4 1] Ea:;;‘;'ﬂ'ﬁg;ﬂe called the “synchronized madule. ©
03 112 F”equiremem test

Enter @ requirement in a DOORS formal module and link ittoa
uniquely mapped objed in the synchronized module. Mow you
can navigate between the requirement and its Simulink objed.

Note The Requirements Management Interface and DOORS both use

the term object, but each uses the term differently. In the Requirements
Management Interface for DOORS, and in this document, the term object
refers to a Simulink model, a Simulink block, a Stateflow block, and elements
of a Stateflow diagram. In DOORS, object refers to each numbered element in
the synchronized formal module for the objects in a Simulink model. DOORS
assigns each of these objects a unique object identifier. In this document,
these objects are referred to as DOORS objects.

Synchronizing a Model with DOORS

In “Starting the Requirements Management Interface for DOORS” on page
3-5, you open MATLAB, open DOORS, and open a project in DOORS. Begin
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the process of mapping requirements in DOORS to a Simulink model by first
synchronizing the model with the open project in DOORS. Synchronization
maps a hierarchical representation of a Simulink model’s blocks and Stateflow

objects to a formal module in a DOORS project. Later, you use this formal
module to add requirements.

Use the following procedure to synchronize a Simulink model with DOORS:

1 In the MATLAB Command Window, type sf_car at the MATLAB prompt to
open the demo model sf_car.mdl.

2 In the Simulink model, from the View menu, select Model Explorer.

E& Model Explorer

File Edit View Tools Add Help
[ smax Ems®i/7/0 o0 +8]sHgma=a
JJSealch: | by Black Type | Tope: [Gain | |E|’ Search
todel Hisrarchy | Contents of: of car Model Properties
E--@Slmulmk Foot |Name |B Main ICaI\backs I History | Description I =
ﬁEaseWorkspace N
& Wscar 6y Contgnaion (i) Model Information for: sf car
Source file:  D:workWATLAR buildydeliwpimatlsbitonboxtst
@ Last Saved: Tue Mar 16 03:35:03 2004
g Engine Created On:  Tue Jun 02 16:12:01 1992
T Hus Is Modified: no
2-] Threshold Calzulation Hodellveisiongales
ﬂ User Inputs
] Vehicle —
=1 engine RPM
R shift_logic
E transmission
=1 wehicle mph (vellow] & throttls 3

@ sfun
Eﬂ o |4 | o

Contents | Search Results Bevert | Help | Apply |

B

-
3 Select the Synchronize Requirements with DOORS tool in the Model
Explorer window. The DOORS settings dialog box opens, as shown.
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E! DOORS settings {my_sf_car) x|

DOORS zurrogate module path [Uze $odelM amed for model name]:

|.£$MndelName$| Browse |

¥ Copy DOORS surrogate item links to Simulink objects
¥ Copy Simulink DOORS links to DOORS surogate items

Additional synchronization objects

I Mone [Recommended) LI

[+ Save DOORS sumogate module after synchronization

W Save Simulink model after spnchonization [recommended)

Sunchronize Cancel Save zetting |

4 Click Synchronize.

Synchronizing creates and opens a DOORS formal module for the model,
which appears as shown.

| Formal module */My Test Project/sf_car' current 0.0 - DDORS ;Iglil

File Edt “ew Insert Link Analysis Table Tools User MATLAE Help

BSE| =¥ [x v|==]8 £

|Jpcors matLag nterface | [[alevels =] [ e S22 52 |

|t E R ol N o B =
=== EETH |~ BT

Bl sf _car D | Biock Hame 2 Black Type Block Detelod? | =]
1sf_car

M e

1 1sf _car Block Diagram False

o >
A

|Username: Administrator |Exclusive edit mode

Notice that by default the DOORS formal module contains only one
synchronized object, which corresponds to the top-level diagram. To include
all the model blocks in the DOORS formal module, use the following
procedure, “Customizing the Level of Synchronization Detail” on page 3-15.

Customizing the Level of Synchronization Detail

The DOORS surrogate module always contains the model objects that have
DOORS requirement links and objects that were previously synchronized.
You can choose a desired detail level to make the surrogate better reflect the
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model. Additional synchronization objects improve the surrogate detail at the
expense of slower synchronization.

To include all the model blocks in the DOORS formal module, use the
following procedure.

1 Open the sf_car model.

2 From the Tools menu in the Simulink window select Requirements >
Synchronize with DOORS. The DOORS settings dialog box opens, as
shown. Another way to access this dialog box is to select the Synchronize

-
Requirements with DOORS tool in the Model Explorer window.

E! DOORS settings {my_sf_car) x|
DOORS zurrogate module path [Uze $odelM amed for model name]:

|.£$MndelName$| Browse |

¥ Copy DOORS surrogate item links to Simulink objects
¥ Copy Simulink DOORS links to DOORS surogate items

Additional synchronization objects

I Mone [Recommended) |
[+ Save DOORS sumogate module after synchronization

W Save Simulink model after spnchonization [recommended)

Sunchronize Cancel Save zetting |

3 From the drop-down list in the Additional synchronization objects
pane, select Complete All blocks, subsystems, states, and
transitions.

4 Click Synchronize. The DOORS formal module for the model appears as
shown.
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| Formal module */Test Project/sf_car' current 0.0 - DOORS ;Iﬂlil
File Edt Wew Insert Link Analysis Table Took User MATLAE Help
CEEINEEERE R = |8 = &' (M % 3= |
|[pocrs matLag nterface | [[alevels x| e 2 W [ =E === T £ B T 4 |2 W7
T L1106 gear B [ Biock Name 2 Block Type Biook Deletea? |
L1109 CALCTH T
Bl 1,11 transmission 79 | 1.11.4.4 Torque ratio Loakup False
1.11.1 He .
0 | 1.11.4.6 impeller Fen Falss
+1,11,2 gear
1.11.3 Hout gl | 1.11.4.6 quotient Praduct False
[=1-1,11.4 Torque Corve 22 I 1.11.4.7 speed ratio Product False
11::; :ﬁ‘ 3 | 1.11.4.8 turbine Product False
111.4.3K factor &4 | 11149 Ti Cnutport False
“1.11.4.4 Torque &5 | 1.11.4.10 Tt Cutport False
1.11.4.5 impeller L. .
-1.11.4.6 quotien & | 1.11.5 transmission ratio Subidystem False
1.11.4.7 speed r 27 | 11151 Tin Inport False
T e % | 11152 gear Inport False
~1.11.4.10 Tt g9 | 1.11.5.3 Nout Inport False
[j-l‘lll.sltlr:nin}\sswon r on I 1.11.5.4 Look-Up Table Lookup False
ALEA Tin
11152 gear 91 | 11155 Product Froduct False
1.11.5.3 Maut 2 | 1.11.5.6 Product1 Product False
+1,11,5.4 Look-Ug
93 Cutport False
e | 11157 T?ut P
- 1,11.5.6 Product % | 1.11.5.8 Nin Outport False
11157 Tout % 1118 Ti Cratport. False
rranm 5 | 1.11.7 Tout Outpor: False
-+1.11.7 Tout 97 | 1.12 vehicle mph (yellow) & throttle %  Scape False
1.12 vehicle mph {yellow ]
N | | | iy
|Username: Administrator [Exclusive edit mode A

Notice the following:

The formal module is named sf_car in the title bar, after the model.

The left pane displays a node for each synchronized object. All nodes are
expanded and the pane is scrolled to the bottom.

The right pane displays a DOORS object for each model object, which
consists of the model object title only. It is also scrolled to the bottom.

Each DOORS object has a unique identifier displayed in the ID column.
For example, the identifier for the DOORS object for the Product block
turbine in the preceding figure is 83.

Each DOORS object has a hierarchical identifier displayed in the Block
Name column, which represents its relationship to other objects in the
engine model. The hierarchical identifier of each block begins with 1,
the hierarchical identifier for the model sf_car that contains them.

For each DOORS object, there is a Block Type description that
identifies each object as a particular block or a subsystem.
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® You can add additional information columns to the right pane with the
Insert Column tool #¢ in the DOORS toolbar.

shown.

File Edit WYiew Simulation Format Tools Help

DeEd&| &8

5 In the Simulink model, right-click and drag a copy of the Scope block, as

=10l x|

30 Nomal || O g B 2 BRER T ®

sf_car.mdl
e e Choose Start from
the Simuiation meny
to run the simuiation.
12 T
engine AP
P ger
T =T
Uszar Inputs issi e
TRnsmission
E Brke —— —
1
Treote ArEmission speed
Doubie-click to
open tire GLY vehiel mph
fyelow)
. and sefect an vehicle & thmttle 951
input manuever spead ™|
E wehizle mph
- - fyelow)
Theshod Sakulation & thmttle 9%
- |
i |
Ly |
Ready 100% odeS
New block added

-
6 Select the Synchronize Requirements with DOORS tool again.

The synchronized module is updated with the new block, as shown.
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| Formal module */Test Project/sf_car’ current 0.0 - DOORS =101 x|
Fie Edt View Insert Link Analysis Table Tools User MATLAE Help
H&EwE &5 v S 7 EEE|E
[oooRs matLAe Interface x| | [alllevels =] | Stc TEETH |~ B
=)-sf_car D | Block Name 3] Black Type Block Deteted? =
=1 sf_car —
#I-1.1 Engine # | 1.11.4.6 quotient Product False
1.2 Mux .
+]- 1.3 Threshold Calculation 2 I 1.114.7 speed ratio Froduct False
1.4 User Inputs; Passing Ma 83 I 1.11.4.8 turbine Product False
1.5 User Inputs: Gradual Ac 8 | 11148 Ti Outport Falss
1.6 User Inputs: Hard brakir
1.7 User Inputs: Coasting 25 I 1.11.4.10 Tt Outport False
#- 1.6 Wehicle 26 | 1.11.5 transmission ratio SubSystem False
1.9 engine RFM .
+1-1.10 =hift_logic 87 | 11161 Tin Inport False
% 1.1 bransmissian %2 | 1.115.2 gear Inpart False
1.12 vehicle mph (yellow) & 20 I 1.115.3 Nout Inport False
1.13 vehicle mph {wellow) & o I 11154 Look-Up Tabl Looks Fal.
11.5.4 Look-Up Table ackup s
91 | 1.11.5.6 Product Froduct False
92 | 1.115.6 Product! Praduct False
93 | 1.115.7 Tout Outport Falss
%4 | 1.115.8 Nin Outport False
95 | 1118 Ti Cutport False
9% | 1117 Tout Cutport False
97 | 1.12 vehicle mph (yellow) & throttle % Seope False
%8 | 1.13 vehicle mph (yellow) & throttle %  Scope False
1

Ll »

4 / |

Username: Administrator Exclusive edit mode

7

New block and link

Note The Requirements Management Interface for DOORS does not detect
model changes made after a synchronization. It is up to you to synchronize

a changed model

with the DOORS formal module.

In the Simulink model, delete the added Scope block and resynchronize.

The deleted block appears at the bottom of the list of objects in the formal

module and its entry in the Block Deleted column is True. If you want,
you can delete this entry by right-clicking the line and selecting Delete.

Otherwise, the module records the former presence of the deleted block.

Before you close the DOORS project, save the synchronized module in

DOORS.
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Customizing the DOORS Synchronization Settings

The DOORS settings dialog box lets you control not only the level of
synchronization detail, but also the actions that the Requirements
Management Interface for DOORS performs upon synchronization.

1 From the Tools menu in the Simulink window select Requirements >
Synchronize with DOORS. The DOORS settings dialog box opens, as
shown. Another way to access this dialog box is to select the Synchronize

-
Requirements with DOORS tool in the Model Explorer window.

E! DOORS settings {my_sf_car) x|

DOORS zurrogate module path [Uze $odelM amed for model name]:

|.£$MndelName$| Browse |

¥ Copy DOORS surrogate item links to Simulink objects
¥ Copy Simulink DOORS links to DOORS surogate items

Additional synchronization objects

I Mone [Recommended) LI

[+ Save DOORS sumogate module after synchronization

W Save Simulink model after spnchonization [recommended)

Sunchronize Cancel Save zetting |

The DOORS surrogate module path field identifies the module within
the DOORS database. You can specify a module with either a relative
path (starting with ./) or a full path (starting with /). Relative paths are
appended to the current DOORS project. Absolute paths must specify a
project and a module name.

After you synchronize a model, the Requirements Management Interface
for DOORS automatically updates the DOORS surrogate module path
field with the actual full path. It also saves the unique module identifier

with the module, to identify when the surrogate is renamed.

If you select a new module path, or if the surrogate module is renamed, the
Resolve Surrogate Conflict dialog box appears when you click Synchronize,
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as shown below. It gives you the options to reuse the previous module, to
continue with the specified path, or to abort synchronization.

<) Resolve Surrogate Conflick o ] |

The model "my_sf_car'’ was previously synchronized with DOORS module 'y
Test Project/ry_sf_car".
and the module name iz specified as "my_sf_car".

Do you want to reuse the previous module or continue with the specified
module name?

Cantinus | Abarnt |

2 Use the following options in the DOORS settings dialog box to customize
your synchronization settings:

Copy DOORS surrogate item links to Simulink objects — If this
check box is selected, at the time of synchronization the Requirements
Management Interface for DOORS copies all the requirement links
created from the surrogate module items into the appropriate Simulink
model objects.

Copy Simulink DOORS links to DOORS surrogate items — If this
check box is selected, at the time of synchronization the Requirements
Management Interface for DOORS copies all the requirement links
created directly from the Simulink model into the appropriate surrogate
module items.

Keeping both these check boxes selected ensures that your requirement
link information is completely synchronized.

Additional synchronization objects — Lets you select the level
of synchronization detail, as described in “Customizing the Level of
Synchronization Detail” on page 3-15.

Save DOORS surrogate module after synchronization — If this
check box is selected, the DOORS formal modules are automatically
saved upon synchronization. If you clear the check box, you will have to
manually save them.

Save Simulink model after synchronization (recommended) —
If this check box is selected, the Simulink model is automatically saved
upon synchronization. It is recommended that you use this option.

3 After you select the desired configuration, click Save Settings.
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Linking Requirements to the DOORS Synchronized
Module

After you create or resynchronize a synchronized module, you can add
requirements for its objects in another DOORS formal module. Each
requirement is then linked to its DOORS object in the synchronized module.
This establishes recognizable requirements in the Requirements Management
Interface for DOORS.

In “Creating a DOORS Requirement Object” on page 3-7, you created a
Transmission Requirements object in the Requirements formal module in
DOORS.

Now use the following procedure to add this requirement to the synchronized
module you created for the sf_car model in “Synchronizing DOORS with
the Simulink Model” on page 3-12:

1 Open the Requirements formal module in DOORS.

2 In the DOORS main window, open the synchronized module sf_car and
scroll down to the transmission object.

3 Right-click the transmission object and select Link > Start Link from
the resulting context menus.

4 In the Requirements formal module window, right-click the Transmission
Requirements object and select Link > Make Link from Start from the
resulting context menus.

A link now exists between the transmission object in the synchronized
module and the Transmission Requirements object in the Requirements
module. The presence of the link is indicated by a right-facing arrow for the
transmission object in the synchronized module and a left-facing arrow in
the Transmission Requirements object in the Requirements module, as
shown.
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Username: Administratar Exclusive edit mode

The requirement you install in this section is an example of an official DOORS
requirement for the Requirements Management Interface for DOORS.

You can navigate between the object in the synchronized module and its
requirement in DOORS by right-clicking one of the arrows and selecting from
the resulting pop-up menu. You can also establish more links from the object
to other requirements. Later on, when you display Simulink objects with
DOORS requirements in “Navigating Between Model Objects and DOORS” on
page 3-24, these are the requirements that the Requirements Management
Interface for DOORS detects.
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Navigating Between Model Objects and DOORS

The following sections explain how to create views that show which model
objects have requirements. They also describe how to navigate between
Simulink or Stateflow objects and the associated requirements in DOORS, or
between model elements and the synchronized DOORS formal module.

* “Viewing Model Elements with Requirements” on page 3-24 — Modify the
view of a Simulink model and identify the subsystems and blocks that
have associated requirements

* “Navigating from Simulink to DOORS” on page 3-26 — Navigate to a
requirement in DOORS from its object in Simulink or the Model Explorer

e “Navigating from DOORS to Simulink” on page 3-28 — Navigate from a
requirement in DOORS to its object in Simulink

Viewing Model Elements with Requirements

It is sometimes helpful to distinguish model objects with requirements

from those without requirements in a single glance. The Requirements
Management Interface for DOORS lets you see model elements with
requirements linked to the synchronized module both in Simulink and in the
Model Explorer.

Use the following procedure to display only those model elements with
requirements:

1 In the Simulink model, from the View menu, select Model Explorer.

The Model Explorer window appears with the model highlighted in the
Model Hierarchy pane, as shown.
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The Model Explorer displays only the transmission object, which you
added requirements to in “Linking Objects to DOORS Requirements” on
page 3-7.

3 Select the Highlight Items with Requirements on Model tool in the
Model Explorer toolbar.

The transmission block in the Simulink model becomes highlighted, as
shown.
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Navigating from Simulink to DOORS

If you create requirement links directly from the Simulink or Stateflow object,
you can navigate directly from the object to the DOORS requirement. In
“Linking Objects to DOORS Requirements” on page 3-7, you create a link
from the transmission block in Simulink to the Transmission Requirements
DOORS object.

Use the following procedure to navigate from the transmission block in
Simulink to its associated requirement in DOORS:
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1 In Simulink, open the model sf_car_doors.

2 Right-click on the transmission block and, from the resulting pop-up menu,
select Requirements > 1. “Transmission Requirements” as shown.
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000000307 1 [ Mask Subsystem, .. Link settings ...

The Requirements formal module window opens scrolled to the
Transmission Requirements link.

Navigating Through the Synchronized Module

If you use the synchronized module to create requirement links to DOORS,
as described in “Linking Requirements to the DOORS Synchronized Module”
on page 3-22, then you can navigate between Simulink objects and DOORS
requirements by using the synchronized module as an intermediary. You first
navigate to the unique object in the synchronized module from its object in
Simulink or the Model Explorer. From the synchronized module, you then
access requirements for each object through the linking process in DOORS.

Use the following procedure to navigate from a Simulink object to the object
mapped in the synchronized module:
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1 In Simulink, right-click a block with requirements.
A pop-up menu appears.
2 In the pop-up menu, select Requirements > DOORS Surrogate Item.

If the synchronized module is closed, it opens and the mapped object is
highlighted. If the synchronized module is already open, only the mapped
object is highlighted.

3 Access individual requirements in the synchronized module.

You can access individual requirements by right-clicking the arrows
that appear in the Block Name column for each mapped object with
requirements and making a requirement selection.

Navigating from DOORS to Simulink

If you create two-way requirement links directly from the Simulink or
Stateflow object, you can navigate from the DOORS requirement directly to
the associated object in Simulink or Stateflow. In “Linking Objects to DOORS
Requirements” on page 3-7, you create a link from the transmission block in
Simulink to the Transmission Requirements DOORS object.

Use the following procedure to navigate from the Transmission Requirements
DOORS object to the transmission block in Simulink:

1 In DOORS, open the formal module window Requirements.

2 Select the Simulink Reference sub-node of the Transmission Requirements
node in the left pane, as shown.
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3 From the MATLAB menu in the formal module window Requirements,

select Select item.

The transmission block in the Simulink diagram is highlighted, as shown.
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Navigating Through the Synchronized Module

In DOORS, you can navigate from a requirement in a formal module to its
mapped object in the synchronized module through the left-facing arrows
in the Block Name column for each requirement. This brings focus to the
synchronized module with the owning object selected.

You can navigate from an object in the synchronized module to its Simulink
object as follows:

1 In the DOORS synchronized module, click an object in either the left or
right pane to select it.

2 From the MATLAB menu, choose Select item.

The object opens in its native diagram as follows:

¢ For a Simulink object, the subsystem containing the selected object
opens in Simulink with that block or subsystem selected in the model.
All parent Simulink blocks are selected as well, so that you can reach the
object from any higher-level object.

* For a Stateflow object, the diagram containing the selected object opens
in Stateflow with the object highlighted.

Note Although the MATLAB menu and Select item feature appear in
all DOORS formal modules, you can only use them in a synchronized
formal module.

If the DOORS Block Deleted status for the object is True, you cannot
navigate to the object.




Managing Model
Verification Blocks

You use Model Verification blocks throughout your model to monitor
individual signals relative to limits that you impose on them. Use Model
Verification blocks in conjunction with the Verification Manager tool in the
Signal Builder block to carefully construct simulation tests for your model
from a single location.

“Using Model Verification Blocks” Using Model Verification blocks in
(p. 4-2) Simulink to monitor model signals
against a specified limit

“Using the Verification Manager” Managing the Model Verification

(p. 4-5) blocks in your models with the
Verification Manager

“Managing Verification Linking requirements documents

Requirements” (p. 4-17) to test groups and their Model

Verification block schedule in the
Verification Manager
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Using Model Verification Blocks

You use Model Verification blocks throughout your model to monitor model
signals. You can set a verification block to assert when its signal leaves the
specified limit or range. During simulation, when the signal crosses the limit,
the verification block can

® Stop simulation and bring immediate focus to its part of the model

® Report the limit encounter with a logical signal output of its own, which can
be true if the limit is not encountered and false if the limit is encountered

To see a complete list of all Model Verification blocks and references for
each, see the Model Verification category in the Simulink Block Reference
documentation.

In the following example, a Check Static Lower Bound verification block is
used to stop simulation when a signal from a Sine Wave block crosses its
lower bound limit.

1 Attach a Check Static Lower Bound verification block to the signal from a
Sine Wave block, as shown in the following schematic.

=10l x|

File Edit WYiew Simulation Format Tools Help

D& 2Ry =

Sine Wae Scope
> }g
Gheck Static
Lower Bound
Fl1o0% [ [ |odez v

2 Set the model to run for 2 seconds while the Sine Wave block outputs a
signal with an amplitude of 1 and a frequency of pi radians per second.

3 Open the Check Static Lower Bound block and set the parameters as
follows:
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ZBlock Parameters: Check Skat 2=

—Checks_SMin [mask] [link]

Azzert that the input signal iz greater than [or optionally equal to] a
static lower bound.

=
F

Lower bound:

|1

[V Inclusive boundary

[v Enable assertion

Simulation callback when assertion fails [optional]:

[V Stop simulation when assertion fails

[ Output assertion signal

Select icon type: I graphic LI

Ok I Lancel | Help | Apply |

A verification block is enabled for an assertion when the Enable assertion
checkbox is selected (this is the default setting). According to the preceding
property settings, the Check Static Lower Bound block is set to detect a
signal value of -1 or lower. If this signal is detected, simulation is stopped.

Run the simulation.

The model stops simulating after 1.5 seconds, when the output is -1, as
shown. This brings focus to the asserting verification block, which is
highlighted.
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The stop in simulation is also accompanied by the following status
diagnostic message.

1 simulation Diagnostics: check_low

_lol x|
‘Wiew  Font Size

| Message Source Reported by Surmary
[] fs ion detected in 'che heck

r Bound'...

4

I»]
| 0 check_low/Check Static Lower Bound

Assertion detected in ‘check lowiCheck Static Lower Bound' attime 1.500000

Open | Help | Close |

5 You can disable the block from asserting its limit by clearing the Enable

assertion checkbox, which has the following effect on the block’s
appearance in the model.
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Using the Verification Manager

You can manage the Model Verification blocks in your models from a central
location with the Verification Manager tool of the Signal Builder block. Use
the following topics to learn how to manage Model Verification blocks in your
Simulink models:

® “Opening the Verification Manager” on page 4-5

e “Enabling and Disabling Model Verification Blocks with the Verification
Manager” on page 4-9

Opening the Verification Manager

In this topic you create a model that you use to examine the Verification
Manager in Simulink in the following steps:

1 Create the following example model in Simulink.
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Typically, a Signal Builder block provides test signals for an entire model
from one location. The example model contains a Signal Builder block
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feeding five test signals to Model Verification blocks. Signals 1 through 4
are sent directly to Check Static Upper Bound Model Verification blocks.
The fifth signal is sent to a subsystem that contains a Check Static Upper
Bound verification block.

Each Check Static Upper Bound verification block is set to assert for an
upper bound of 1 (property Upper bound = 1). Blocks 1, 2, 3, and 5 appear
crossed out because they are disabled (property Enable assert is cleared).
Block 4 is enabled (property Enable assert is checked).

Double-click the Signal Builder block in the preceding model to open its
Signal Builder dialog box.

Groups of test signals Show Verification Settings

<) Signal Bui{der {test_signals;/Signal Builder) [m] ﬂ
ol k|
=EH/ 4 B — . X ¥RV
/group1 \(groupQ \(groupa \
2 --Gignal 1omm oo e b

Hame: |Sigral 1 | | Zignal E [}

Sigmal 3
Index: |1 - | | Silg'nal 4 | F
4 3
Click to select signal Signal 1 (#17 []

The Signal Builder dialog box displays tabbed pages for three groups of
signal values. Each group contains independent values for all five signals.
However, only a subset of the signals is displayed for each group. For
example, groupl displays signals 1 and 2. For more information on the
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Signal Builder block, see "Working with Signal Groups" in the Simulink
documentation.

3 In the Signal Builder dialog toolbar, select the Show Verification Settings

tool .

The Verification block settings pane and the Requirements pane
appear as shown.

Requirements pane
Verificafion pane
<) Signal Builder (test_signals/Signal Builder) -0 ﬂ
File Edit Group Signal Axes Help £
SH| 4 AT W' | 1wV
/group1 \(group2 \(groupa \
, [= =
2 r-Signa 1?"""" """"?""'""‘; Verification block|setting
H H h / -
0 A S s ;

i
! W Chacl Satic | ey B A hd
: L i

; Requirements:

4

1 |Mo requirements in this aroup

Time (sec)
Hame: |Signal 1 | [ :}c_mai 2 [
igma
Index: |1 - | | S‘ilg'nal 4 | . F
Click to select signal Signal 1 (1) []

By default, the Verification block settings pane lists all Model
Verification blocks for the model, grouped by subsystem. The
Requirements pane lists the requirements document links for the current
signal group. See “Managing Verification Requirements” on page 4-17 for
details on adding requirement document links in the Signal Builder dialog
box. For now, delete the Requirements pane in the next step.
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4 Just above the Verification block settings pane, select to close the
Requirements pane.
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The example Verification block settings pane displays five Model

Verification blocks. Four are in the top level of the model, and one is in a
subsystem.

5 Select the List Enabled Verifications tool I2—1 in the Verification block
settings toolbar.

The Verification block settings pane now shows only the enabled Model
Verification blocks for the current group, as shown.

4-8



Using the Verification Manager

Check Static Upper Bound 4

6 Select the Show Verification Block Hierarchy tool =11 to list all Model
Verification blocks for the current group again.

Enabling and Disabling Model Verification Blocks
with the Verification Manager

In this section you use the Verification Manager to selectively enable and
disable Model Verification blocks in group tests. In “Opening the Verification

Manager” on page 4-5, you open the Verification Manager in the Signal
Builder, as shown.
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The Verification block settings pane in the preceding example lists the
Model Verification blocks in the model. Each verification block has a preceding
status node that indicates whether its assertion is enabled or disabled and
whether that setting applies universally or to the active group. The preceding
status node can be one of the following.

Node Status
Verification block is disabled for this group. Click to enable
O for current group.

Verification block is enabled for the current group. Click
to disable for current group.

Verification block is enabled for all test groups.

Use the Verification Manager to enable or disable model verification blocks in
the test_signals model you created in “Opening the Verification Manager”
on page 4-5, as follows:

1 In the Verification Manager, click the empty check box next to the Check
Static Upper Bound 2 node to enable it for the current group (groupl).

Enabling a disabled block in the Verification block settings pane leads
to the following change in block appearance in the model.

4-10



Using the Verification Manager
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Because it is enabled in the current group, the Check Static Upper Bound 2
block gains an Override label and loses its cross-out. The meaning behind
the change in appearance becomes clearer when another group is selected.

2 In the Signal Builder dialog box, select the group2 tab and click the empty
check box next to the Check Static Upper Bound 3 block to enable it for

the current group (group2).

Disabled but enabled in current group (group1)

Verification Manager - group1

¢ Upper Bound 2

¥ Check Static Upper Bound 4
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The Check Static Upper Bound 3 block loses its cross to indicate that it is
enabled for the current group. However, Check Static Upper Bound 2 gains
a cross because it is enabled in another group, but not this one.

The change in appearance of the Check Static Upper Bound blocks in the
preceding steps is exemplary of the change in appearance of every other Model
Verification block except the Assert block. The change in appearance of the
Assert block is summarized in the following table:

Assert
Block Description
: Enabled for all groups
K @ Disabled in current group
: Enabled in current group
e mide
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Using Enabling and Disabling Tools in the Verification
Manager

If you have many verification blocks, it is tedious to enable and disable blocks
individually. For this reason, the Verification Manager lets you enable and
disable blocks from ancestors through selections from a context menu. These
selections vary with the node as follows:

Node Context Menu Selections

o ¢ Enable contents of all groups
¢ Enable contents by group

® Group enable contents

® Group disable contents

¢ Enable by group

O e Enable for all groups

® Group enable

Enable for all groups

%]
[ ]

® Group disable

As an example, assume that the following groups are defined in the
Verification Manager for a model with five Model Verification blocks.

group1 group2 group3

3* test_signals 3* test_signals 3* test_signals

[ check Static Upper Bound 1 [ check Static Upper Bound 1 [ check Static Upper Bound 1
Check Static Upper Bound 2 [ check Static Upper Bound 2 [ check Static Upper Bound 2
[ check Static Upper Bound 3 Check Static Upper Bound 3 [ check Static Upper Bound 3
Check Static Upper Bound 4 Check Static Upper Bound 4
Pl Subsystem Pl Subayatem

[ check Static: Upper Bound 5 C [ check Static: Upper Bound 5 [ [ check Static Upper Bound 5

1 Right-click the test_signals node and select Enable contents of all
groups.
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group1 group2 group3

Check Static Upper Bound 1
Check Static Upper Bound 2
Check Static Upper Bound 3
Check Static Upper Bound 4
.'E* Subaystem

[ Check Static Upper Bound 5

Check Static Upper Bound 1
Check Static Upper Bound 2
Check Static Upper Bound 3
Check Static Upper Bound 4
ubzyatem

[ Check Static Upper Bound 5

Check Static Upper Bound 1
Check Static Upper Bound 2
Check Static Upper Bound 3
Check Static Upper Bound 4
.'E* Subaystem

[ Check Static Upper Bound 5

Applying the Enable contents of all groups selection to the model node
enables all contained Model Verification blocks, for all test groups, in all
contained subsystems.

Right-click test_signals and select Contents enable by group.

group1 group2 group3

[ check Static Upper Bound 1
[ check Static Upper Bound 2
[ check Static Upper Bound 3

: [ check Static Upper Bound 1
[ check Static Upper Bound 2
Check Static Upper Bound 3

[ check Static Upper Bound 1
Check Static Upper Bound 2
[ check Static Upper Bound 3

[ check Static: Upper Bound 5 [ check Static: Upper Bound 5 [ [ check Static Upper Bound 5

Applying the Contents enable by group selection to the model node
restores the previous individually enabled/disabled settings for each block
in each group.

Right-click test_signals and select Contents group enable.

group1 group2 (unchanged) group3 (unchanged)

[ check Static Upper Bound 1
[ check Static Upper Bound 2
[ check Static Upper Bound 3

Check Static Upper Bound 1
Check Static Upper Bound 2
Check Static Upper Bound 3
Check Static Upper Bound 4
ubsystem

Check Static Upper Bound 5

[ check Static Upper Bound 1
[ check Static Upper Bound 2
Check Static Upper Bound 3

[ check Static: Upper Bound 5 [ check Static Upper Bound 5

Applying Contents Group enable to the test _signals model node in
groupl individually enables all contained blocks for groupl, but leaves
the other groups untouched.

4 Right-click test_signals and select Contents group disable.
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group1 group2 (unchanged) group3 (unchanged)
s s i

[ check Static Upper Bound 1
[ check Static Upper Bound 2
[ check Static Upper Bound 3
[[] Check Static Upper Bound 4

[ check Static Upper Bound 1
[ check Static Upper Bound 2
Check Static Upper Bound 3
[[] check Static Upper Bound 4

[ check Static Upper Bound 1
[ check Static Upper Bound 2
[ check Static Upper Bound 3
[ check Static Upper Bound 4

[ check Static: Upper Bound 5

[ check Static: Upper Bound 5

[ check Static Upper Bound 5

Applying Contents group disable to the test_signals model node in
groupl individually disables all contained blocks for groupl, but leaves
the other groups untouched.

Right-click Check Static Upper Bound 1 and select Block enable for
all groups.

group1 group2 group3
3;_ test_signals 3;_ test_signals 3;_ test_signals
i i pper Bournd 1 i i pper Bournd 1 Lipper Bound 1
[ check Static Upper Bound 2 [ check Static Upper Bound 2 [ check Static Upper Bound 2
[ check Static Upper Bound 3 Check Static Upper Bound 3 [ check Static Upper Bound 3
[ check Static Upper Bound 4 [[] check Static Upper Bound 4 [[] Check Static Upper Bound 4
.'E* Subaystem .'E* Subaystem .'E* Subaystem
[ check Static: Upper Bound 5 [ check Static: Upper Bound 5 [ [ check Static Upper Bound 5

Applying Block enable for all groups to the individual groupl block
node for Check Static Upper Bound 1 in groupl enables this block for all

groups.

Right-click Check Static Upper Bound 1 and select Block enable by
group.

group1 group2 group3
3;_ test_signals 3;_ test_signals 3;_ test

signals

[ [ i Upiper Bound 1 8 : [ [ pet Bound 1
[ check Static Upper Bound 2 [ check Static Upper Bound 2 [ check Static Upper Bound 2
[ check Static Upper Bound 3 Check Static Upper Bound 3 [ check Static Upper Bound 3
[ check Static Upper Bound 4 [[] Check Static Upper Bound 4
.'E* Subaystem .'E* Subaystem
[ check Static: Upper Bound 5 C [ check Static: Upper Bound 5 [ [ check Static Upper Bound 5

Applying Block enable by group to the individual groupl block node
for Check Static Upper Bound 1 in groupl restores the previous
individually enabled/disabled state to this block for all groups. This lets
you enable or disable this node individually for each group.
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7 Right-click Check Static Upper Bound 1 and select Block group enable.

group3 (unchanged)

o] test_signal
ic Uppet Bound 1 i ic [ pet Bound |
[ check Static Upper Bound 2 [ check Static Upper Bound 2 [ check Static Upper Bound 2
[ check Static Upper Bound 3 Check Static Upper Bound 3 [ check Static Upper Bound 3
[ check Static Upper Bound 4 [[] check Static Upper Bound 4 [[] Check Static Upper Bound 4
.'E* Subaystem .'E* Subaystem .'E* Subaystem
[ check Static: Upper Bound 5 [ check Static: Upper Bound 5 [ [ check Static Upper Bound 5

Applying Block group enable to the individual groupl block node for
Check Static Upper Bound 1 in groupl enables this block for this group
only. This is equivalent to selecting the empty check box in groupl for
this node.

8 Right-click Check Static Upper Bound 1 and select Block group

disable.
group1 group2 (unchanged) group3 (unchanged)
3;_ test_signals 3;_ test_signals 3;_ test_signals
[ i Lppet Bound 1 8 ic Lpper Bound 1 [ [ Static Lppet Bound 1

[ check Static Upper Bound 2 [ check Static Upper Bound 2 [ check Static Upper Bound 2
[ check Static Upper Bound 3 Check Static Upper Bound 3 [ check Static Upper Bound 3
[ check Static Upper Bound 4 [[] check Static Upper Bound 4 [[] Check Static Upper Bound 4
.'E* Subaystem .'E* Subaystem .'E* Subaystem
[ check Static: Upper Bound 5 [ check Static: Upper Bound 5 [ [ check Static Upper Bound 5

Applying Block group disable to the individual block node for Check
Static Upper Bound 1 in groupl disables this block for this group only.
This is equivalent to clearing the check box for this node.



Managing Verification Requirements

Managing Verification Requirements

In “Using the Verification Manager” on page 4-5, you learn how to use the
Verification Manager to manage Model Verification blocks along with signal
group tests in a Simulink model. The combination of test groups and their
schedules of enabled and disabled Model Verification blocks is used to verify
the correct behavior for your Simulink model. In this section you learn how to
link the requirements to this combination that specify correct behavior.

You can link requirements documents to individual verification blocks just as
you can for any Simulink block. See “Adding Requirement Links to an Object”
on page 2-8 for details on linking requirements documents to individual

Simulink blocks.

You can link requirements documents to test groups and their scheduled
Model Verification blocks through the Requirements pane of the Verification
Manager in the Signal Builder. By default, when you display the Verification
Manager in the Signal Builder window, the Requirements pane appears,

as shown.

<) Signal Builder (test_signals/Signal Builder

File Edit Group Signal Axes Help

== =S — L [EE

/group1 \(group2 \(groupa \

o
fg

x » ball _j@w

=10l x|

LI

r

b-Signal-ti--------

)

HEEE

Verification block settings:

i j
-
W Chacl Thatic | ey Booeaed A
1 1 »

Requirements:

Mo reguirements in this group

Click to select signal

Signal 1 (#13 []

Time {zec)
Hame: |Signs| 1 | | Simmal 3 Rt
Index: |1 - [ [ F equirements pane
3
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1 Right-click anywhere in the Requirements pane.
A pop-up menu appears.
2 From the pop-up menu, select Edit/Add Links.

The Requirements dialog box appears, as shown.

E! Requirements: Signal Builc

Requirements IDocumEandBH |

Mew |
Capy |
Delete |
L
L oo |

Dezcription: I

Diocument: I

Diocument type: IUnspecifiedT_l,Jpe j Browse... |

current selection in:

Location:

(Typedidentiieq) | S20ch test =)

|Jzer tag: I

Update fields with DOORS | Wiord | Ewncel |

ok I Cancel | Help | Apply

You can also access the Requirements dialog box for a Signal Builder
block by right-clicking it in the Simulink model and selecting Edit/Add

Requirements.

3 Add links to requirements documents as described in steps 4 through 9 of
“Adding Requirement Links to an Object” on page 2-8.

The descriptions for the links that you add appear in the Requirements

pane, as shown.
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<} Signal Builder (test_requirements/Signal Bui -0 ﬂ
File Edit Group Signal Axes Help
== = — o L TR Wi 4wV

J aroupt / group2 Y groups L]

!
F-Signad-Be--mmmmmm e g - yTTTTTTTTtiTTTToooTa Verification block settings:

__________ — | = j
H H H H H
.
! ! ! ! | Chacl Static | lnnar B 4
: |« Wf

i Requirements:

ra

: Requiremert 1

% |Requiremert 2 4\

~

New requirements

Hame: [signal 3 | |
Index: |3 - | |

Click to select signal Signal 3 (#3) []

4 Right-click a requirement link and select View to view the requirements
document in its native editor.

5 Right-click a requirement link and select Delete to delete it.
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Using Model Coverage

Model coverage helps you to validate your model tests by measuring how
thoroughly the model objects are tested. The following sections describe tools
in the Simulink Performance Tools that measure and display model coverage

for the model.

“Introduction to Model Coverage”
(p. 5-3)

“Using Model Coverage” (p. 5-7)

“Specifying Model Coverage
Reporting Options” (p. 5-10)

“Understanding Model Coverage
Reports” (p. 5-19)

“N-Dimensional Lookup Table
Report” (p. 5-25)

“Signal Range Analysis Report”
(p. 5-31)

Introduces you to the concept of
model coverage and how it measures
the effectiveness of your model
during testing

Shows you how to use model
coverage and the tests to determine
the effectiveness of your model
during testing

Shows you how to select the
model coverage measurements and
reports that are performed during
simulation

Shows and describes the different
parts of a basic model coverage
report

Describes the interactive chart that
summarizes the extent to which
elements of a Lookup Table are
accessed

Lists the maximum and minimum
signal values at each block in the
model measured during simulation
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“Colored Simulink Diagram
Coverage Display” (p. 5-34)

”»

“Using Model Coverage Commands
(p. 5-39)

“Model Coverage for Embedded
MATLAB Function Blocks” (p. 5-45)

Shows you how to use the option
to display coverage of a model by
coloring its elements

Shows you how to perform and
report model coverage tests during
simulation with MATLAB commands

How to use model coverage for
Embedded MATLAB Function blocks
and interpret the results
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Introduction to Model Coverage

Model coverage determines the extent to which a model test case exercises
simulation pathways through a model. The percentage of pathways that a
test case exercises is called its model coverage. Model coverage is a measure
of how thoroughly a test tests a model. Model coverage therefore helps you
to validate your model tests.

How Model Coverage Works

Model coverage works by analyzing the execution of blocks that directly or
indirectly determine simulation pathways through your model. If a model
includes Stateflow charts, the tool also analyzes the states and transitions of
those charts. During a simulation run, the tool records the behavior of the
covered blocks, states, and transitions. At the end of the simulation, the tool
reports the extent to which the run exercised potential simulation pathways
through each covered block.

See “Understanding Model Coverage Reports” on page 5-19 for an example of
a model coverage report along with descriptions of the coverages it contains.
Before you do, you might need to review the types of coverages that model
coverage performs in “Types of Model Coverage” on page 5-3.

Types of Model Coverage

The tool performs any or all of the following types of coverage analysis,
depending on the coverage options you select:

¢ Cyclomatic complexity

Cyclomatic complexity is a measure of the structural complexity of a model.
It approximates the McCabe complexity measure for code generated from
the model. In general, the McCabe complexity measure is slightly higher
because of error checks that the model coverage analysis does not consider.

Model coverage uses the following formula to compute the cyclomatic
complexity of an object (block, chart, state, etc.)
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N
c = Z(an -1)
1

where N is the number of decision points that the object represents and o
is the number of outcomes for the nth decision point. The tool adds 1 to
the complexity number computed by this formula for atomic subsystems
and Stateflow charts.

Decision coverage

Examines items that represent decision points in a model, such as a Switch
block or Stateflow states. For each item, decision coverage determines the
percentage of the total number of simulation paths through the item that
the simulation actually traversed.

Condition coverage

Examines blocks that output the logical combination of their inputs (for
example, the Logic block), and Stateflow transitions). A test case achieves
full coverage if it causes each input to each instance of a logic block in the
model and each condition on a transition to be true at least once during
the simulation and false at least once during the simulation. Condition
coverage analysis reports for each block in the model whether the test
case fully covered the block.

Modified condition/decision coverage (MC/DC)

Examines blocks that output the logical combination of their inputs (for
example, the Logic block), and Stateflow transitions to determine the
extent to which the test case tests the independence of logical block inputs
and transition conditions. A test case achieves full coverage for a block if,
for every input, there is a pair of simulation times when changing that
input alone causes a change in the block’s output. A test case achieves full
coverage for a transition if, for each condition on the transition, there is at
least one time when a change in the condition triggers the transition.

Lookup table (LUT) coverage

Examines blocks, such as the 1D Lookup block, that output the result of
looking up one or more inputs in a table of inputs and outputs, interpolating
between or extrapolating from table entries as necessary. Lookup table
coverage records the frequency that table lookups use each interpolation
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interval. A test case achieves full coverage if it executes each interpolation
and extrapolation interval at least once. For each LUT block in the model,
the coverage report displays a colored map of the lookup table indicating
where each interpolation was performed.

Blocks That Receive Model Coverage

The following table lists the Simulink blocks analyzed by the tool and the
kind of coverage analysis performed for each block.

Block Decision Condition MC/DC LUT
1D Lookup o
2D Lookup .
ND Lookup .

ND o
Interpolation
using
Prelookup

ND Direct °
Lookup

Abs .

Combin. . .
Logic

Discrete-Time| ®
Integrator
(when
saturation
limits are
enabled)

Embedded . . .
MATLAB
Function

Fen (Boolean .
operators
only)
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Block Decision Condition MC/DC LUT
For .

If .

Logic . .

MinMax .

Multiport .

Switch

Rate Limiter | ®

(Relative to
slew rates)

Relay .

Saturation o

Stateflow o . .
(see note

below)

Subsystem . . .
Switch .

SwitchCase o

While .

Note Model coverage provides decision coverage for Stateflow states, events,
and state temporal logic decisions. It also provides decision, condition, and
MCDC coverage for Stateflow transitions. See the section "Understanding
Model Coverage for Stateflow Charts" in your Stateflow documentation for
details on the model coverage of Stateflow charts.
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Using Model Coverage

To develop effective tests with model coverage,

Develop one or more test cases for your model (see “Creating and Running
Test Cases” on page 5-7).

Run the test cases to verify that the model behavior is correct.
Analyze the coverage reports produced by Simulink.

Using the information in the coverage reports, modify the test cases to
increase their coverage or add new test cases that cover areas not covered
by the current set of test cases.

Repeat the preceding steps until you are satisfied with the coverage of
your test set.

Note Simulink comes with an online demonstration of the use of model
coverage to validate model tests. To run the demo, enter simcovdemo at the
MATLAB command prompt.

Creating and Running Test Cases

Model coverage provides two MATLAB commands, cvtest and cvsim, for
creating and running test cases. The cvtest command creates test cases to be
run by the cvsim command (see “Creating Tests with cvtest” on page 5-39 and
“Running Tests with cvsim” on page 5-41).

You can also run the coverage tool interactively as follows:

1 From the Simulink Tools menu, select Coverage Settings.

Simulink displays the Coverage Settings dialog box, as shown.
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. ). Coverage Settings - sf_car - |EI|1|

The Simulink model coverage tool records the execution of contral
flowy constructs within Simulink blocks and Stateflow diagrams

£ Resuts I Repaort I Options I
[ Enable Coverage Reporting

r Coverage Instrumentation Path (' for whale moadel)
i

Erowse

r Coverage metrics
V| Decision Coverage V| Condition Coverage

¥ MCDC Coverage V| Look-up Table Coverage
¥ | Signal Range Coverage

Ok | Cancel | Help | Apply |

The Coverage Settings dialog box has four tabs. The Coverage tab is
displayed by default.

2 Select Enable Coverage Reporting.

By default, this setting is disabled. When you select it, the Browse button
for the Coverage Instrumentation Path is enabled along with the check
boxes of the Coverage metrics section, as shown.

. ). Coverage Settings - sf_car - |EI|1|

The Simulink model coverage tool records the execution of contral
flowy constructs within Simulink blocks and Stateflow diagrams

coverage | Resuts | Report | ptions |
¥ Enable Coverage Reporting

r Coverage Instrumentation Path (' for whale moadel)
i

Erowse

r Coverage metrics
¥ Decision Coverage ¥ Condition Coverage

¥ MCDC Coverage ¥ Look-up Table Coverage
V' Signal Range Coverage

0K Cancel Help Apply
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Selecting Enable Coverage Reporting also enables fields on the other
tabs of the Coverage Settings dialog box.

Select the coverages you want to appear in the coverage report.

For a complete inventory of coverage selections in all four tabs of the
Coverage Settings dialog box, see “Specifying Model Coverage Reporting
Options” on page 5-10.

Select OK to close the dialog box.

Select Start from the Simulation menu or the Start button on the
Simulink toolbar to start simulation of the model.

By default, Simulink saves coverage data for the current run in
the workspace object covdata and cumulative coverage data in
covCumulativeData. This data appears in an HTML report that is
displayed automatically at the end of simulation.

Note You cannot run simulations with both model coverage reporting and
acceleration options enabled. Simulink disables model coverage reporting if
the accelerator is enabled.

Block reduction optimization and conditional branch input optimization
are disabled when you perform coverage analysis because they interfere
with coverage recording.
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Specifying Model Coverage Reporting Options

A large part of using model coverage is specifying model coverage reporting
options in the Coverage Settings dialog box. You open this dialog from the
Tools menu of a Simulink window by selecting Coverage Settings. The
Coverage Settings dialog box appears with its Coverage tab in focus, as
shown.

«): Coverage Settings - sf_car 10l =|

The Simulink model coverage tool records the execution of contral
flioe structs within Sirmulink blocks and Stateflov diagrams

g | Resuts I Repaort I Options I
[ Enable Coverage Reporting

r Coverage Instrumentation Path (' for whale moadel)
i

Erowse

r Coverage metrics
V| Decision Coverage V| Condition Coverage
¥ MCDC Coverage V| Look-up Table Coverage
¥ | Signal Range Coverage

Ok | Cancel | Help | Apply |

The following topics describe the settings for each tab of the Coverage Settings
dialog box:

® “Coverage Tab” on page 5-10

e “Results Tab” on page 5-12

e “Report Tab” on page 5-13

® “Options Tab” on page 5-17

Coverage Tab

You select the model coverages calculated during simulation in the fields of
the Coverage tab of the Coverage Settings dialog box.
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Enable Coverage Reporting

Causes Simulink to gather and report the specified model coverages during
simulation. When you select the Enable Coverage Reporting field, all
other fields in the Coverage page of the Coverage Settings dialog box are
enabled, as shown.

«): Coverage Settings - sf_car = 10l =|

The Simulink model coverage tool records the execution of contral
flowy constructs within Simulink blocks and Stateflow diagrams

coverage | Resuts | Report | ptions |
¥ Enable Coverage Reporting

r Coverage Instrumentation Path (' for whale moadel)
i

Erowse

r Coverage metrics
¥ Decision Coverage ¥ Condition Coverage

¥ MCDC Coverage ¥ Look-up Table Coverage
V' Signal Range Coverage

Ok | Cancel | Help | Apply |

Coverage Instrumentation Path

Path of the subsystem for which Simulink gathers and reports coverage data.
By default, Simulink generates coverage data for the entire model.

To restrict coverage reporting to a particular subsystem,

1 In the Coverage page of the Coverage Settings dialog box, click Browse.

Simulink displays a System Selector dialog box.
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«): System Selector = 10l =|

@ sf_car

y Engine

mmreshold Calculation
y User Inputs

] Vehicle

] shift logic

#+ transmission

Ok Cancel |

2 Select the subsystem for which you want coverage reporting to be enabled
and click OK to close the dialog box.

Coverage Metrics

Select the types of test case coverage analysis that you want the tool to
perform. See “Types of Model Coverage” on page 5-3 for more information.

Results Tab

You select the destination of model coverage results from model coverage in
the Results page of the Coverage Settings dialog box.

«): Coverage Settings - sf_car : 10l =|

The Simulink model coverage tool records the execution of contral
flowy constructs within Simulink blocks and Stateflow diagrams

Coverage Resuts |Rep0r1 I Cptions I

vV Save cumulative results in workspace variable

cvdata object name: IcovCumuIativeData

vV Save last run in waorkspace variable

cvdata object name: Icovdata
[" Increment variable name with each simulation (varl, var2, )
vV Update results on pause

vV Display coverage results using model coloring

0K Cancel Help Apply
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Save Cumulative Results in Workspace Variable

Causes model coverage to accumulate and save the results of successive
simulations in the workspace variable specified in the cvdata object name
field below. The coverage running total in the workspace variable is updated
with new results at the end of each simulation.

Save Last Run in Workspace Variable

Causes model coverage to save the results of the last simulation run in the
workspace variable specified in the cvdata object name field below.

Increment Variable Name with Each Simulation

Causes Simulink to increment the name of the coverage data object variable
used to save the last run with each simulation. This prevents the current
simulation run from overwriting the results of the previous run.

Update Results on Pause

When you pause during simulation the first time, causes the HTML model
coverage report to appear with model coverage results recorded up to the
pause point. When you resume simulation and later pause or stop simulation,
the model coverage report reappears in updated form with coverage results
up to the current pause or stop time.

Display Coverage Results Using Model Coloring

After simulation, causes coloring of Simulink blocks according to their level
of model coverage. Blocks highlighted in light green received full coverage
during testing. Blocks highlighted in light red received incomplete coverage.
In addition, model coverage results for each block receiving it is available in
context-sensitive form. See “Colored Simulink Diagram Coverage Display” on
page 5-34 for a complete description.

Report Tab

You select the model coverage test sessions (runs) reported by model coverage
in the Report page of the Coverage Settings dialog box.
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«): Coverage Settings - sf_car 10l =|

The Simulink model coverage tool records the execution of contral
flowy constructs within Simulink blocks and Stateflow diagrams

Coverage I Resuts Report |Opti0ns I

¥ Generate HThL repart Settings |

" Cumulative runs
& Lastrun
Additional data to include in report (cvdata objects):

Ok | Cancel | Help | Apply

Generate HTML Report

Causes Simulink to create an HTML report containing the coverage data.
Simulink displays the report in the MATLAB Help browser at the end of the
simulation. Click the Settings button to select various reporting options
(see “Settings” on page 5-14).

Settings

The HTML Settings dialog box allows you to choose various model coverage
report options. To display the dialog box, click Settings on the Report page
of the Coverage Settings dialog box. The HTML Settings dialog box appears.

=01

¥ Include each testin the rmodel summary

¥ Produce bar graphs in the madel summary

[T Use two color bar graphs {red hlue)

r Display hit'count ratio in the model summary

[~ Donot report fully covered moadel objects

¥ Include cyclomatic camplexity numbers in summary
¥ Include cyclomatic camplexity numbers in hlock details

Ok Cancel
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Include each test in the model summary. When this option is selected,
the model hierarchy table at the top of the HTML report includes columns
listing the coverage metrics for each test. When this option is not selected, the
model summary reports only the total coverage.

Produce bar graphs in the model summary. Causes the model summary
to include a bar graph for each coverage result. The bar graphs provide a
visual representation of the coverage.

Use two color bar graphs (red, blue). Causes the report to use red and
blue bar graphs instead of black and white. The color graphs might not print
well in black and white.

Display hit/count ratio in the model summary. Reports coverage
numbers as both a percentage and a ratio, e.g., 67% (8/12).

Do not report fully covered model objects. Causes the coverage report
to include only model objects that the simulation does not cover fully. This
option is useful when you are developing tests, because it reduces the size of
the generated reports.

Include cyclomatic complexity numbers in summary. Includes the
cyclomatic complexity (see “Types of Model Coverage” on page 5-3) of the
model and its top-level subsystems and charts in the report summary. A
cyclomatic complexity number shown in boldface indicates that the analysis
considered the subsystem itself to be an object when computing its complexity.
This occurs for atomic and conditionally executed subsystems as well as
Stateflow blocks.

Include cyclomatic complexity numbers in block details. Includes the
cyclomatic complexity metric in the block details section of the report.

Cumulative Runs
Display the coverage results from successive simulations in the report.

Whenever the check box Save cumulative results in workspace variable
in the Results page is selected, a coverage running total is updated with new
results at the end of each simulation. In a cumulative coverage report the

results in the rightmost column reflect that running total value. The report is
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organized so that you can easily compare the additional coverage from the
most recent run with the coverage from all prior runs in the session.

You can make cumulative coverage results persist between MATLAB sessions
by using cvsave to save results to a file at the end of the session and cvload
to load the results at the beginning of the session. Note that the cvload
parameter RESTORETOTAL must be 1 in order to restore cumulative results.

When you save the coverage results to a file using cvsave and a model name

argument, the file also contains the cumulative running total. When you load
that file back into the coverage tool using cvload, you can select whether you
want to restore the running total from the file.

When you restore a running total from saved data, the saved results are
reflected in the next cumulative report that is generated. If a running
total already exists when you restore a saved value, the existing value is
overwritten.

Whenever you report on more than a single simulation, the coverage displayed
for truth tables and lookup-table maps is based on the total coverage of all
the reported runs. In the case of a cumulative report, this includes all the
simulations where cumulative results were stored.

Calculating cumulative coverage results is also possible at the command line
via the + operator. The following script demonstrates this usage:

covdatat cvsim(test1);
covdata2 = cvsim(test2);
cvhtml('cumulative_report', covdata + covdata2);

Last Run
Display only the results of the most recent simulation run in the report.

Additional Data to Include in Report

Names of coverage data from previous runs to include in the current report
along with the current coverage data. Each entry causes a new set of columns
to appear in the report.
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Options Tab

You select important options for model coverage reports in the Options page
of the Coverage Settings dialog box.

«): Coverage Settings - sf_car 10l =|

The Simulink model coverage tool records the execution of contral
flowy constructs within Simulink blocks and Stateflow diagrams

Coverage I Resutts I Repart  Options
[T Treat Sirmulink Logic blocks as short-circuited

[~ wWarn when unsupported blocks exist in model
[ Disable coverage for blocks used in asserdion checks

Ok | Cancel | Help | Apply |

Treat Simulink Logic Blocks as Short-Circuited

Applies only to condition and MC/DC coverage. If enabled, coverage analysis
treats Simulink logic blocks as though they short-circuit their input. In other
words, Simulink treats such a block as if the block ignores remaining inputs if
the previous inputs alone determine the block’s output. For example, if the
first input to an And block is false, MC/DC coverage analysis ignores the
values of the other inputs in determining MC/DC coverage for a test case.

You should select this option if you plan to generate code from a model and
want the MC/DC coverage analysis to approximate the degree of coverage
that your test cases would achieve for the generated code (most high-level
languages short-circuit logic expressions).

Note A test case that does not achieve full MC/DC coverage for
non-short-circuited logic expressions might achieve full coverage for
short-circuited expressions.
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Warn When Unsupported Blocks Exist in a Model

Select this option if you want the tool to warn you at the end of the simulation
if the model contains blocks that require coverage analysis but are not
currently covered by the tool.

Disable Coverage for Blocks Used in Assertion Checks

Disable coverage of blocks from Simulink’s Model Verification library (see the
Model Verification category in the Simulink Block Reference documentation).
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Understanding Model Coverage Reports

The coverage report generated by model coverage contains the basic reports
described in the following topics:

“Summary Report Section” on page 5-19
“Details Report Section” on page 5-20
“Decisions Analyzed Table” on page 5-22
“Conditions Analyzed Table” on page 5-22
“MC/DC Analysis Table” on page 5-23

For an understanding of model coverage reports for Stateflow diagrams and
their objects, see "Understanding Model Coverage for Stateflow Charts" in
Stateflow documentation.

Summary Report Section
The coverage summary section has two subsections: Tests and Summary.
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Coverage Report for fuelsys
Tests
Test 1

Started Execution: 05-Apr-2001 145:51:41
Ended Execution: 05-Apr-2001 15:52:08

Summary
todel Hierarchy: Test 1

D1 ] MCDC TEL
1. fuelsys 20% 9% — 13% " 1%
2....E&0senszor 50% NA NA NA
3.. .. MAP senszor 50% NA NA NA
4. ... engine speed 50% NA NA NA
5....e.ng|ne gas B0% — N N N
dynamics
=P Mixing & 50% — NA NA NA
Combustion
T Throttle & B35 — N N N

Manifald

The Tests section lists the simulation start and stop time of each test case and
any setup commands that preceded the simulation. The heading for each test
case includes the test case label, for example "Test throttle," specified using
the cvtest command.

The Summary section summarizes the results for each subsystem. Clicking
the name of the subsystem takes you to a detailed report for that subsystem.

Details Report Section
The Details section reports the model coverage results in detail.
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Details:

1. Model "fuelsys”

Child 5; EGO sensor, MAP sensor, engine speed, engine gas dynamics, fuel rate controller, speed sensor, throttle

command, throttle sensor

Meiric Coverage (this ohject)
Cyclomatic Complexity 1

Decision (D1 Ha

Condition (C1) Ha

MCDC (C1) A

Lookup Table Ha

2. Subsystem "EGO sensor”

Parent: ffuelsys

Meiric Coverage (this ohject)
Cyclomatic Complexity 1]

Decision (D1 Ha

Switch block “Switch"

Coverage (inc. descendants)

86

38% (33/140) decision outcomes

34% (11/32) condition outcomes

13% (2/16) conditions reversed the outcome
1% (15/1508) interpolation intervals

Coverage (inc. descendants)
1
0% (1/2) decision outcomes

Parent: fuelsys/EGO sensor
Uncovered Links: »
Meiric Coverage
Cyclomatic Complexity 1
Decision (D1 0% (1/2) decision outcomes
Decisions analyzed:
logical trigger input 0%

false (output is from 3rd input port)

trae (output is from 1st input port)

017940
17940/17940

The Details section starts with a summary of results for the model as a
whole followed by a list of subsystems and charts that the model contains.
Subsections on each subsystem and chart follow. Clicking the name of a
subsystem or chart in the model summary takes you to a detailed report

on that subsystem or chart. The section for each subsystem starts with a
summary of the test coverage results for the subsystem and a list of the
subsystems that it contains. The overview is followed by block reports, one for
each block that contains a decision point in the subsystem.

Each section of the detailed report summarizes the results for the metrics
used to test the object (model, subsystem, chart, block) to which the section
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applies. The sections for models and subsystems give results for the model
and subsystem considered as a covered object and for the contents of the
model or subsystem.

You can also access an individual object’s subsection of the Details section
from the Simulink model as follows:

1 Right-click a Simulink block
A pop-up menu appears.

2 In the pop-up menu, select Coverage, and from the resulting pop-up
submenu, select Report.

The model coverage report appears, scrolled to the applicable Details
subsection.

Each section can include coverage results for more than one simulation run.
The report displays the results for each simulation run in a separate column.
A numeric prefix in the column heading indicates the run that produced the
data.

Decisions Analyzed Table

This table lists possible outcomes for a decision and the number of times that
an outcome occurred in each test simulation.

Decisions analyzed:
logical trigger input 0%
false (output is from 3rd input port) 0717940
trze (output is from 1st input port) 17940717940

The report highlights outcomes that did not occur in red. Clicking the block
name causes Simulink to display the block diagram containing the block.
Simulink also highlights the block to help you find it in the diagram.

Conditions Analyzed Table

This table lists the number of occurrences of true and false conditions on each
input port of a block.
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Conditi

Description:

#1T

#1F

input port 1

431

17060

input pott 2

17541

MC/DC Analysis Table

This table lists the MC/DC input condition cases represented by the
corresponding block and the extent to which the reported test cases cover the

condition cases.

MC/DC

in parenth did not occur)

Decision/Condition:
expression for output

input port 1

input port 2

#1 True Out #1 False Out

FF

TF
FD

Each row of the table represents a condition case for a particular input to the
block. A condition case for input n of a block is a combination of input values

such that changing the value of input n alone is sufficient to change the value
of the block’s output. Input n is called the deciding input of the condition case.

The table uses a condition case expression to represent a condition case. A
condition case expression is a character string where

® The position of a character in the string corresponds to the input port

number.

® The character at the position represents the value of the input (T means
true, F means false).

® Boldfacing a character indicates that it corresponds to the value of the

deciding input.

For example, FTF represents a condition case for a three-input block where

the second input is the deciding input.

The table’s Decision/Condition column specifies the deciding input for an
input condition case. The #1 True Out column specifies the deciding input
value that causes the block to output a true value for a condition case. The
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#1 True Out entry uses a condition case expression, for example, FF, to
express the values of all the inputs to the block, with the value of the deciding
variable indicated by boldfacing.

Parentheses around the expression indicate that the specified combination of
inputs did not occur during the first (or only) test case included in this report.
In other words, the test case did not cover the corresponding condition case.
The #1 False Out column specifies the deciding input value that causes the
block to output a false value and whether the value actually occurred during
the first (or only) test case included in the report. The report adds additional
#n True Out and #n False out columns for additional test cases, where n is
the number of the test case.

If you select Treat Simulink Logic blocks as short-circuited in the
Coverage Settings dialog box (see “Specifying Model Coverage Reporting
Options” on page 5-10), MC/DC coverage analysis does not check whether
short-circuited inputs actually occur. The MC/DC details table uses an x in
a condition expression (e.g., TFxxx) to indicate short-circuited inputs that
were not analyzed by the tool.

Navigation Arrows. The section for each block contains a backward and a
forward arrow. Clicking the forward arrow takes you to the next section in the
report that lists an uncovered outcome. Clicking the back arrow takes you
back to the previous uncovered outcome in the report.
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N-Dimensional Lookup Table Report

This report section displays an interactive chart that summarizes the extent
to which elements of a Lookup Table are accessed. In the following example, a
Lookup Table of 10-by-10 elements filled with random values is accessed with
x and y indices generated from two Sine Wave blocks.

E!twodtahle_lookup ;Iglll

File Edit WYiew Simulation Format Tools Help

Sin@eﬂ—l—p o |§|
i Scope
Lookup
Table (n-0v

Sine Wave2

Ready 100% ode3
4

In this example, table indices are 1, 2,..., 10 in each direction. The Sine
Wave2 block is out of phase with the Sine Wavel block by pi/2 radians. This
generates x and y numbers for the edge of a circle, which becomes apparent
when you examine the resulting Lookup Table coverage.
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%" Web Browser - C:/TEMP/tp362889_twodtable_lookup_navigati 1[ - |EI|1|
File Edit Go Desktop ‘Window Help A X
Dw| % Rl o o BODE &0
J « * S | @ | M | Locatian: ID:.Work.lModeIs.l‘rn0deI_c:overagenwodtable_lookup_cov.Html LI
Surnrnary | Details | Help
A
Subsystem "Lookup Table (n-D)"
Parent: Awodtable_lookup
Uncovered Links:
Metric Coverage
Cyclomatic Complexity 0
Look-up Tahle 17% (24/143) interpolation intervals
Lookup Table Details
0
1-20
u 21-40
u
[ | | | 41 -E60
[ | [ |
ooo M 51-80
W =:0 o
ch:rTEMPnpssz... * |
4

The report contains a two-dimensional table representing the elements of the
Lookup Table. The element indices are represented by the cell border grid
lines, which number 10 in each dimension. Areas where the Lookup Table
interpolates between table values are represented by the cell areas. Areas
of extrapolation left of element 1 and right of element 10 are represented by
cells at the edge of the table, which have no outside border.

The number of values interpolated (or extrapolated) for each cell (execution
counts) during testing is represented by a shade of green assigned to the cell.
Each of six levels of shading and the range of execution counts represented
are displayed on the side of the table.

If you click an individual table cell, you receive a dialog that displays the
index location of the cell and the exact number of execution counts generated
for it during testing. The following example shows the contents of a color
shaded cell on the right edge of the circle:
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Lookup Table Details

0 <} Interpolation Inter¥al {6,9) =1o =]
|| ) ;1 220 Region: Interpalation
O i Row: h<X<=h
a o 41-80 Column: <y <=9
..... W &1-80 Execution counts: 51
W =

Notice that the selected cell is outlined in red. You can also click on
extrapolation cells on the edge of the table, as shown.

Lookup Table Details

o <} Interpolation Inter¥al (4,11} =10 x]
B 1 ;1 220 Region: Extrapolation/Saturation
0 Row: Jede=4
[ | [ | 41-80 Column: ¥ =10
..... N 61-a30 Execution counts: 0
W =80

A bold grid line indicates that at least one block input equal to its exact index
value occurred during the simulation. Click the border to display the exact
number of hits for that index value, as shown in the following example:

Lookup Table Details

<) Break Point #9 I ] 3
1-20
u 21-40
] Value: ¥=9
] W 41 -60
[ | [ |
EEE B 61-80 Execution counts: 0
W =a0

The following example model uses a Lookup Table of 10-by-10-by-5 elements
filled with random values.
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Elthreedtable_lookup 10l =|

File Edit WYiew Simulation Format Tools Help

|

Sine Wawve

3.0 Tiu)

[

f—1)

Scope

Sine Wawve1

Lookup
Table (n-0Y

Ready 100% ode3
4

Both the x and y table axes have the indices 1, 2,..., 10, while the z axis has
the indices 10, 20,...,50. Lookup Table values are accessed with x and y indices
generated from the two Sine Wave blocks in the preceding example, and a z
index generated from a Ramp block.

After simulation, the following Lookup Table report appears:
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%VWeb Browser - C:/TEMP/tp135929_threedtable_lookup_navigation.html 1[ - |EI|1|

File Edit Go Desktop ‘Window Help E 4

D& dBEBR o o HOHE =0
[

J - = | = | i | Location: IC:ITEMP.ftm35929_threedtable_lookup_navigation.Html

Surnrnary | Details
El

Subsystem "Lookup Table (n-D)"
Parent: Ahreedtable_lookup

Uncovered Links:

Metric Coverage

Cyclomatic Complexity 0
Look-up Tahle B% (43/754) interpolation intervals

Table map was not generated due to the table size.

Force Map Generation.

Jl COTEMPApI3S...

4]

R

Instead of a two-dimensional table, the link Force Map Generation appears,
which displays the following tables:
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%" Web Browser - Look-up Table Coverage Details
File Edit Go Desktop ‘Window Help a

Dw| % Rl o o BODE &0
J - = = | @ | % | Locatian: ID:.Workmdodels.l‘model_c:0verage.ﬂhreedtable_lookup_cov_ﬂ3.Htm| LI
Lookup Table Details -l
Iz <10 [ 10 =<=lz<=20 [ 20 <1z ==30 [
[ [ [ [ ]|
[ | | O | | |
O O
O O
O O
[ | | | | |
[ [ [ ] | | |
30 < Iz == 40 [ 40 < 13 == 40 [ Iz =50
O
O O
O O
O O
[ | | | | |
| | || | | |
| | B
JI Look-up Tahble... = |
4

Notice that Lookup Table coverage for a three-dimensional Lookup Table block
is reported as a set of two-dimensional tables. If you overlay these tables last
on top of first, you notice that the coverage values corkscrew up to the reader.

The vertical bars represent the exact z index values: 10, 20, 30, 40, 50. If a
vertical bar is bold, this indicates that at least one block input was equal to
the exact index value it represents during the simulation. Click a bar to get a
report of coverage for the exact index value it represents.

You can report Lookup Table coverage for Lookup Tables of any dimension.
Coverage for four-dimensional tables is reported as sets of three-dimensional
sets like those in the preceding example. Five-dimensional tables are reported
as sets of sets of three-dimensional sets, and so on.
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Signal Range Analysis Report

If you select Signal Range Coverage in the Coverage Settings dialog
box, you receive a Signal Range Analysis report at the bottom of the model
coverage report. This report gives you the maximum and minimum signal
values at each block in the model measured during simulation.

Note When Inline parameters is enabled, some signal range information
may be missing (for example, if there is a gain with a value of 1). To get a
complete signal range report, clear the Inline parameters option on the
Optimization pane of the model’s active configuration set.

You can access the Signal Range Analysis report quickly with the Signal
Ranges link in the nonscrolling region at the top of the model coverage
report, as shown for the fuelsys model.

%" Web Browser - fuelsys Coverage Report 51 =]
File Edit Go Deskiop Window Help A X
D&l o | BOE &0
J * * 8 | % | M | Locatian: ID:Workmdodels.i‘fuelsys_cov.h'tml LI
. e .
Surnrnary | Details | Signal Ranges
Signal Ranges: A 2l
Hierarchy Min value Max value
fuelsys
... Constant2 il u]
... Constant3 12 12
... Constantd il u]
... Constants il u]
... High Speed (rad./Sec.) 700 Foo
... Momireal Speed 300 300
... EGO sensar
i =
...... Swvitch 0180421 12
...... RTalue 1] 1
-
JI fuelsys Cover... = |
\ Y

Link to Signal Range Coverage report
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Each block is reported in hierarchical fashion: child blocks are displayed

directly under parent blocks. Each block name in the signal report is a link
that brings the block into immediate focus. For example, selecting the link
EGO sensor displays this block highlighted in its native diagram, as shown.

(ol x]
File Edit WYiew Simulation Format Tools Help
DSE&| ¢ ER [ ]» =|Nmal BB B
Fault-Tolerant Fuel Control System
C-“;;OSSQ S!&I;fﬁﬂ’ofﬂ thmttle sansor L
e snnaton .
menu to run " thrctte =rgnespesd e
the model, thmttle
command
Maorminal engine | Fretaangs  MARI—
Speed speed —-C—e engire speed
:
00 o & speed s2nsor fudd mte —P{ Tl ainfud mtio
o 4%}
Speed Eao engine
{rd fSec.) i’—’ £ gas
12 g .
Usa this awitch EGQ s=nsor yname
to farce the —b_KD—D
engine to MAP
overspead
AP s=nsor eter=d Fuel airfuel
fuel mte mbstu R o
To toggie contmlier
a switch,
double-click Use these switches 1o
on its icon. simulate any combination
of sensorfailures
Ready [1o02 [ [ |odeds v

Selecting the link Switch displays this block in its own subsystem by looking
under the mask for EGO sensor, as shown.
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SlLink: fuelsys/EGD sensor * 10l =|
File Edit WYiew Simulation Format Tools  Help

D|D’“H§|%E|DQ » llNormaI 'H

i

SirV alue Ot
Sutl

boolkanil) AT

RTWY alue

Envimnrment
Contmlier
2
2
Ready [1o02 |odets v
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Colored Simulink Diagram Coverage Display

Model coverage displays model coverage results for individual blocks directly
in Simulink diagrams. If you enable this feature, model coverage does the
following:

e Highlights (colors) blocks that have received model coverage during
simulation

® Provides a context-sensitive display of summary model coverage
information for each block

Use the following topics to learn how to enable and interpret colored diagram
coverage display:

¢ “Enabling the Colored Diagram Display” on page 5-34
* “Displaying Model Coverage with Model Coloring” on page 5-35

® “Accessing Coverage Information for Colored Blocks” on page 5-37

Enabling the Colored Diagram Display

You enable the model coverage colored diagram display as follows:
1 In the Simulink window, from the Tools menu, select Coverage Settings.
The Coverage Settings dialog box appears.

2 In the Coverage tab of the Coverage Settings dialog box, select Enable
Coverage Reporting.

3 Select the Results tab, as shown.
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<) Coverage Settings - fuelsys =]

The Simulink model coverage tool records the execution of contral
flowy constructs within Simulink blocks and Stateflow diagrams

Coverage Resuts |Rep0r1 I Cptions I

vV Save cumulative results in workspace variable

cvdata object name: IcovCumuIativeData

vV Save last run in waorkspace variable

cvdata object name: Icovdata
[" Increment variable name with each simulation (varl, var2, )
vV Update results on pause

vV Display coverage results using model coloring

Ok | Cancel | Help | Apply |

The Display coverage results using model coloring option is selected
by default for all models. This check box becomes visible only after Enable
Coverage Reporting is enabled in the Coverage tab. You can disable
this option for the current session by clearing this check box.

Displaying Model Coverage with Model Coloring

You enable display coverage as described in “Enabling the Colored Diagram
Display” on page 5-34, After you enable this display, any time that the model
generates a model coverage report, individual blocks receiving coverage are
highlighted with light green or light red, as shown.
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File Edit WYiew Simulation Format Tools Help

Fault-Tolerant Fuel Control System

Chmqosse Sfal’;:iﬂ'm thottle s=nsor L
e Simulation ine speedca
menu to run = thratde e >

the model, thmottle
command
thotle ange  MAP

Mo rminal engine

Speed Epesd —-—e] ergine spesd
s
o £ speed sensor fudd mte — fued ainfud mtio

e 4>_O\o—>
Speed EGo engine
{rad fSec.) i’—’ g gas

EGO dynarics
Use this awitch oxmiiimit!

to force the —b_KD—D
engine to MAP

overspead
AP s=nsor eter=d Fuel airfuel
fuel mie

miture mio

To toggle contmlier
a switch,
double-click Use these swiches o
on its icon. simulate any combination
of sensorfailures
Ready [1o02 [ [ |odeds v

For users seeing the above figure in black and white, the colored blocks are
marked with a & (light green) or a R (light red) in their lower right-hand
corner. The light green Manual Switch blocks received full coverage during
testing. The light red blocks (the engine speed Manual Switch block, and
the fuel rate controller and engine gas dynamics subsystems) received
incomplete coverage during testing. Blocks with no color highlighting

(the Constant blocks, Scope blocks, and the throttle command Repeating
Sequence block) received no coverage at all.

Note To restore the Simulink model diagram to its original colors, right-click
a colored block and select Coverage from the resulting context menu followed
by Remove information from the resulting submenu.
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Accessing Coverage Information for Colored Blocks

“Displaying Model Coverage with Model Coloring” on page 5-35 describes
the highlighted Simulink display that appears after simulation when you
enable display coverage with model coloring in the coverage settings for the
model. Along with the highlighted Simulink display, a Coverage Display
window appears, as shown.

Coverage: fuelsys
= T -

el

Coverage Display Window

Click on a shaded block to see coverage information. Use contest menus to
toggle between click-based and mouse-over object selection.

If you click a colored block in the Simulink model, its summarized coverage
appears in the Coverage Display window. In the preceding example, the
following summary report appears when you click the fuel rate controller
subsystem block:

Cowverage: fuelsys
= b T -
Subsystem “fuel rate controller™
[eision B3% (75/1.20)
MCDC 56% [3/16]

el L=

{lick to change mouse resporse.

(ick for model coverage report.

Summary coverage information appears in the Coverage Display window for
the block, whose hyperlinked name appears at the top of the window. Click
the hyperlink to access the appropriate section of the coverage report for this
block. You can also see this section of the report by right-clicking the block
and selecting Coverage > Report.

You can set the Coverage Display window to display coverage for a block in
response to a hovering mouse cursor instead of a mouse click in one of two

ways:

® Select the down arrow on the right side of the Coverage Display window,
and, from the resulting menu, select Focus.
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e Right-click a colored block and select Coverage from the resulting context
menu followed by Display details on mouse-over from the resulting
submenu.
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Using Model Coverage Commands

Using model coverage commands lets you automate the entire model coverage
process with MATLAB scripts. You can use model coverage commands

in MATLAB to completely set up model coverage tests, execute them in
simulation, store the results, and report them.

Use the following topics, in the order of the work flow of creating, running,
storing, and reporting model coverage tests to understand model coverage
commands:

® “Creating Tests with cvtest” on page 5-39 — Start the process by creating a
test object that specifies the model or part of the model tested.

¢ “Running Tests with cvsim” on page 5-41 — Execute (simulate) the test
object. This creates a results object for the test object.

¢ “Producing HTML Reports with cvhtml” on page 5-42 — Create a report
for the results object.

* “Saving Test Runs to a File with cvsave” on page 5-42 — Save the test
object and its results object in a file.

® “Loading Stored Coverage Test Results with cvload” on page 5-43 — Load
the file containing test and results objects to create new reports of model
coverage data.

Creating Tests with cvtest

The cvtest command creates a test specification object. Once you create the
object, you simulate it with the cvsim command.

The call to cvtest has the following default syntax:

cvto = cvtest(root)
root is the name of, or a handle to, a Simulink model or a subsystem of
a model. cvto is a handle to the resulting test specification object. Only

the specified model or subsystem and its descendants are subject to model
coverage testing.
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The following command creates a test object with a specified label used for
reporting results:

cvto = cvtest(root, label)
The following command creates a test with a setup command:

cvto = cvtest(root, label, setupcmd)
The setup command is executed in the base MATLAB workspace just prior
to running the instrumented simulation. This command is useful for loading

data prior to a test.

The returned cvtest object, cvto, has the following structure.

Field Description

id Read-only internal data-dictionary
ID

modelcov Read-only internal data-dictionary
ID

rootPath Name of the system or subsystem
instrumented for analysis

label String used when reporting results

setupCmd Command executed in the base
workspace just prior to simulation.

settings.condition Set to 1 if condition coverage is
desired

settings.decision Set to 1 if decision coverage is
desired

settings.mcdc Set to 1 if MC/DC coverage is desired

settings.sigRange Set to 1 if signal range coverage is
desired

settings.tableExec Set to 1 if lookup table coverage is
desired
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Running Tests with cvsim

Once you create a test specification object, you simulate it with the cvsim
command.

Note You do not have to enable model coverage reporting for the model (see
“Creating and Running Test Cases” on page 5-7) to use the cvsim command.

The call to cvsim has the following default syntax:

cvdo = cvsim(cvto)

This command executes the cvtest object cvto by starting a simulation run
for the corresponding model. The results are returned in the cvdata object
cvdo.

You can also control the simulation in a cvsim command by using parameters
for the MATLAB sim command, as shown in the following examples:

® The following command returns the simulation time vector t, matrix of
state values x, and matrix of output values vy.

[cvdo,t,x,y] = cvsim(cvto)

® The following command overrides default simulation values with new
values.

[cvdo,t,x,y] = cvsim(cvto, timespan, options)

See online help for the MATLAB sim command for descriptions of the
parameters t, x, y, timespan, and options in the previous examples.

You can execute multiple test objects with the cvsim command. The following
command executes a set of coverage test objects, cvto1, cvto2, ... and

returns the results in a set of cvdata objects, cdvo1, cvdo2,

[cvdol, cvdo2, ...] = cvsim(cvtol, cvto2, ...)
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You can also use the cvsim command to create and execute a cvtest object in
one command as shown in the following example:

[cvdo,t,x,y] = cvsim(cvto, label, setupcmd)

Producing HTML Reports with cvhiml

Once you run a test in simulation with cvsim, you produce results that are
saved to cvdata objects in MATLAB. Use the cvhtml command to produce an
HTML report of these objects.

The following command creates an HTML report of the coverage results in the
cvdata object cvdo, which is written to the file file in the current MATLAB
directory:

cvhtml(file, cvdo)

The following example creates a combined report of several cvdata objects:

cvhtml(file, cvdoil,cvdo2,...)

The results from each object are displayed in a separate column of the HTML
report. Each cvdata data object must correspond to the same root model or
subsystem, or the function produces errors.

You can specify the detail level of the report with the value of detail, an
integer between 0 and 3, as shown in the following example:

cvhtml(file, cvdol1, cvdo2,..., detail)

Greater numbers for detail indicate greater detail. The default value is 2.

Saving Test Runs to a File with cvsave

Once you run a test with cvsim, save its coverage tests and results to a file
with the function cvsave:

cvsave(filename, model)

Save all the tests and results related to model in the text file filename.cvt:

cvsave(filename, cvtol, cvto2, ...)
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Save the specified tests in the text file filename.cvt. Information about
the referenced models is also saved.

You can also save specified cvdata objects to file. The following example saves
the tests, test results, and referenced models’ structure in cvdata objects to
the text file filename.cvt:

cvsave(filename, cvdol, cvdo2, ...)

Loading Stored Coverage Test Results with cvioad

The cvload command loads into memory the coverage tests and results stored
in a file by the cvsave command. The following example loads the tests and
data stored in the text file filename.cvt:

[cvtos, cvdos] = cvload(filename)

The cvtest objects that are successfully loaded are returned in cvtos, a cell
array of cvtest objects. The cvdata objects that are successfully loaded are
returned in cvdos, a cell array of cvdata objects. cvdos has the same size as
cvtos, but can contain empty elements if a particular test has no results.

In the following example, if restoretotal is 1, the cumulative results from
prior runs are restored:

[cvtos, cvdos] = cvload(filename, restoretotal)

If restoretotal is unspecified or 0, the model’s cumulative results are cleared.

cvload Special Considerations
The following are some special considerations for using the cvload command:

¢ If a model with the same name exists in the coverage database, only the
compatible results are loaded from the file and they reference the existing
model to prevent duplication.

e If the Simulink models referenced in the file are open but do not exist in
the coverage database, the coverage tool resolves the links to the models
that are already open.
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® When you are loading several files that reference the same model, only the
results that are consistent with the earlier files are loaded.

Coverage Script Example

The following example demonstrates some of the common model coverage
commands:

testObj1 = cvtest('ratelim_harness/Adjustable Rate Limiter');
testObji1.label = 'Gain within slew limits';

testObj1.setupCmd = 'load(''within_lim.mat'');";
testObji1.settings.mcdc = 1;

testObj2 = cvtest('ratelim_harness/Adjustable Rate Limiter');
testObj2.label = 'Rising gain that temporarily exceeds slew
limit';

testObj2.setupCmd = 'load(''rising_gain.mat'');"';
testObj2.settings.mcdc = 1;

[dataObj1,T,X,Y] = cvsim(testObj1,[0 2]);
[dataObj2,T,X,Y] = cvsim(testObj2,[0 2]);

cvhtml('ratelim_report',dataObji1,data0Obj2);
cumulative = dataObji1+dataObj2;
cvsave('ratelim_testdata',cumulative);

In this example, you create two cvtest objects, testObj1 and testObj2, and
simulate them according to their specifications. Each cvtest object uses the
setupCmd property to load a data file prior to simulation. Decision coverage is
enabled by default, and MC/DC coverage is enabled as well. After simulation
you use cvhtml to display the coverage results for two tests and the cumulative
coverage. Lastly, you compute cumulative coverage with the + operator and
save the results. For more detailed examples of how to use the model coverage
commands, see simcovdemo.m and simcovdemo2.m in the coverage root folder.

5-44



Model Coverage for Embedded MATLAB Function Blocks

Model Coverage for Embedded MATLAB Function Blocks

This section describes the model coverage for an Embedded MATLAB
Function block function. Model coverage reports tell you what decision
outcomes occur during simulation and the values of the conditions that they
depend on. See the following topics for a description of Embedded MATLAB
Function block model coverage elements and model coverage for an example
Embedded MATLAB Function block function:

“Types of Model Coverage in Embedded MATLAB Function Blocks” on page
5-45 — Lists the types of elements in an Embedded MATLAB Function
block function that receive model coverage during simulation

“Creating a Model with Embedded MATLAB Function Block Decisions” on
page 5-46 — Creates an Embedded MATLAB Function block with decisions
and conditions that you execute later during simulation

“Understanding Embedded MATLAB Function Block Model Coverage”
on page 5-49 — Describes the individual coverages reported in the model
coverage report for the example Embedded MATLAB Function block

Note Model coverage is available to you if you have the Simulink
Performance Tools license.

Types of Model Coverage in Embedded MATLAB
Function Blocks

During simulation, the following Embedded MATLAB Function block function
statements are tested for decision coverage:

Function header — Decision coverage is 100% if the function or subfunction
is executed.

if — Decision coverage is 100% if the if expression evaluates to true at
least once, and false at least once.

switch — Decision coverage is 100% if every switch case is taken,
including the fall-through case.
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e for — Decision coverage is 100% if the equivalent loop condition evaluates
to true at least once, and false at least once.

® while — Decision coverage is 100% if the equivalent loop condition
evaluates to true at least once, and false at least once.

During simulation, the following logical conditions are tested for condition
coverage and MCDC coverage in the Embedded MATLAB Function block
function:

e if statement conditions

® while statement conditions, if present

Creating a Model with Embedded MATLAB Function
Block Decisions

In this topic you use an example model to examine model coverage of an
Embedded MATLAB Function block in Simulink. The following model
contains a single Embedded MATLAB Function block with output data sent
to a Scope block.

E!intersecting_rectangles E - | Ellll

File Edit WYiew Simulation Format Tools Help

D|@H§|%EIDQI> II? INormaI

nun_intersect_test  out 4% :

Scope

Embedded MATLAE Function

Rea [100% [ [ |odez v

Double-click the Embedded MATLAB Function block to specify its program
content as shown.
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+): Embedded MATLAB Editor - Block: intersecting_rectangles; 1 ;lglll
File Edt Text Debug Tools Window Help E 4
D H |t BRoc ART SH|Frr A0 ERE B0 J"‘“‘J"
1 function out = run_intersect test ‘_—__—————ﬂd{_;
Z % Call rect_intersect to see if & moving test rectangle
3 % and a stationary rectangle intersect
4
5 - =1 = =1+1;
6 — Tl = wi+1; .
7 - wout = rect_intersect([xl ¥l 2 2]',[2 4 2 2]'); SUIJ{UI'IdIOI'I
: -
9 - function out = rect_intersectirectl,recti] 4;_—~—~——~_'
10 % Return 1 if two rectangle argueents intersect: 0 if not.
11
1z - leftl = rectlil):
13 - bkottoml = rectl(2);
14 = rightl = leftl + rectl(3):;
15 - +topl = bottoml + rectlid);
16
17 - leftz = rect(l):
18 - hottomZ = rectl(2); Decisions
1= rightz = leftZ + rectZ (3);
Z0 - topZ = bottomZ + rect2(4);
21
22 - if (topl < hottom2 || top2 < bhottoml) <‘/—///
23 - out = 0;
24 - elze ’_//
25 — if (rightl < left2 || rightZ < lefti) >
Z6 - out = 0;
ET|= else
28 - out = 1;
&= end
30 - end
| Ready [tn 1 cal g 4

The run_intersect_test Embedded MATLAB Function block contains two
functions. The top-level function, run_intersect_test, sends the coordinates
for two rectangles, one fixed and the other moving, as arguments to the
subfunction rect_intersect, which tests for intersection between the two.
The origin of the moving rectangle increases by 1 in the x and y directions
with each time step.

The coordinates for the origin of the moving test rectangle are represented by
local data x1 and y1, which are both initialized to -1. For the first sample, x1
and y1 are both incremented to 0. From then on, the progression of rectangle
arguments during simulation is as follows:
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0l
ad
1 Stationary reriunglel =7
A 1=6
p sl t=5
mi t=4
34 t=3
) =2
1 t=1 _
0 ; t=04v—= — :TBSi ret:ﬂngles
il 1 ? 3 4 b ] 7 il 9 |
X

The fixed rectangle is shown in bold with a lower left origin of (2,4) and a
width and height of 2. At time t = 0, the first test rectangle has an origin of
(0,0) and a width and height of 2. For each succeeding sample, the origin of
the test rectangle is incremented by (1,1). The rectangles at sample times
t = 2, 3, and 4 intersect with the test rectangle.

The subfunction rect_intersect checks to see if its two rectangle arguments
intersect. Each argument consists of coordinates for the lower left corner of
the rectangle (origin), and its width and height. x values for the left and right
sides and y values for the top and bottom are calculated for each rectangle and
compared in nested if-else decisions. The function returns a logical value of
1 if the rectangles intersect and 0 if they do not.

Scope output during simulation, which plots the return value against the
sample time, confirms the intersecting rectangles for sample 2, 3, and 4 as
shown.
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Understanding Embedded MATLAB Function Block
Model Coverage

Model coverage reports are generated automatically after a simulation if
you specify them. See “Creating and Running Test Cases” on page 5-7 for
instructions on how to specify a model coverage report.

When simulation is finished, the model coverage report appears in a browser
window. After the summary for the model, the Details section of the model
coverage report reports on each of the parts of the model. Model coverage
for the parts of the example model in “Creating a Model with Embedded
MATLAB Function Block Decisions” on page 5-46 appears in the following
model-block-function order.

Model: intersecting rectangles
Block: Embedded MATLAB Function
Function: run_intersect_test
Decision Lines: 1: function out =

rect_intersect_test

9: function out =
rect_intersect(recti1, rect2)

5-49



5 Using Model Coverage

5-50

22: if (top1 < bottom2 || top2
< bottomt)

25: if (right1 < left2 ||
right2 < left1)

The following subtopics examine the model coverage report for the example
model in reverse function-block-model order. Reversing the order helps you
make sense of the summary information that appears at the top of each
section.

Model Coverage for the Embedded MATLAB Function Block
Function run_intersect_test

Model coverage for the Embedded MATLAB Function function
run_intersect_test is reported under the linked name of the function.
Clicking this link opens the function in the Embedded MATLAB Editor.
Following the linked function name is a link to the model coverage report for
the parent Embedded MATLAB Function block of run_intersect test.

%" Web Browser - intersecting_rectangles Covera -3 =]
File Edit Go Desktop ‘Window Help E 4
Dw| % Rl o o BODE &0
J « * 8 | @ | M |L0c:ati0n: Izml.l’emI_bI0c:k.l‘model_c:0verage.ﬂrdersecting_redangles_cov.Html LI
Surnrnary | Details
Function "run_intersect_test”
Parent: intersecting_rectangles/etl
Uncovered Links: [
Metric Coverage
Cyclomatic Complexity 53
Decision (D1) 100% (5/8) decision outcomes
Condition (C1) 88% (7/8) condition outcomes
MCDC (C1) 75% (3/4) conditions reversed the outcome
” intersecting_... | |
4
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The top half of the report for the function summarizes its model coverage
results as shown. The coverage metrics for run_intersect_test include
decision, condition, and MCDC coverage. These metrics are best understood
by examining the code listing for run_intersect_test that follows.

%Yintersecting_rectangles Coverage Report 1[ - |EI|1|
File Edit ‘Web Desktop Window Help

J « * S | @ | M |L0c:ati0n: ID:Workmd0deIs.l’eml.l’emI_bI0c:k.l‘model_c:0verage.ﬂrdersecting_redangles_cov.Html IZI
function out = run_intersect_test ‘:J
% Call rect_intersect to sSee if two rectangles: to see if
% a test rectangle and a stationary rectangle intersect

xl = xl1+1;
71 = vi+1;

out = rect_intersect([xl ¥1 2 2]',[2 4 2 2]');

function out = rect_ intersect(rectl,recti)

"
D|w [ R = Y, RN N|H

% Return 1 if two rectangle arguments intersect; 0 if not.

o
[ X

leftl = rectlil):

hottoml = rectl(2):

rightl = leftl + rectl(3):;
topl = bottoml + rectl(4);

e e e
BN - T I A

left? = rect(l):

hottom2 = rect (2):

rightz = leftZ + rect2(3):;
topZ = bottomZ + rectl(4);

MO M O
o= O W m

if (topl < bottomZ || topd < hottoml)
out = 0;

[
o

else
if {rightl < left? || rightZ < lefti)
out = 0;

ha
=]

[
-1 m

else

[
[l

out = 1;

o
w

end

o
[}

end

=l
4

Lines with coverage elements are marked by a highlighted line number

in the listing. Line 1 receives decision coverage on whether the top-level
function run_intersect_test is executed. Line 9 receives decision coverage
on whether the subfunction rect_intersect is executed. Lines 22 and 25
receive decision, condition, and MCDC coverage for their if statements and
conditions. Each of these lines is the subject of a report that follows the listing.
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Notice that the condition right1 < left2 in line 25 is highlighted in red.
This means that this condition was not tested for all of its possible outcomes
during simulation. Exactly which of the outcomes was not tested is answered
by the report for the decision in line 25.

The following subtopics display the coverage for each decision line of
run_intersect_test. The coverage for each line is titled with the line itself,
which is linked to display the function with the line highlighted.

Coverage for Linel. The coverage metrics for line 1 appear below the
listing for the function run_intersect_test.

%Yintersecting_rectangles Coverage Report 1[ - |EI|1|
File Edit ‘Web Desktop ‘Window Help

J - = | @ | i |L0c:ati0n: ID:Workmd0deIs.l’eml.l’emI_bI0c:k.l‘model_c:0verage.ﬂrdersecting_redangles_cov.Html IZI

#1: function out = run_intersect_test
Decisions analyzed:
function out = run_intersect_test 100% 1
executed 8/

4

The first line of every function receives coverage analysis indicative
of the decision to run the function in response to a call. Coverage for
run_intersect_test indicates that it executed during testing.

Coverage for Line 9. The coverage metrics for line 9 appear below the
coverage metrics for line 1.
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%Vintersecting_rectangles Coverage Report 1[ - |EI|1|
File Edit ‘Web Desktop Window Help

J - = | @ | i |L0c:ati0n: ID:Workmd0deIs.l’eml.l’emI_bI0c:k.l‘model_c:0verage.ﬂrdersecting_redangles_cov.Html IZI

#9: function out = rect_intersect{rect!,rect?) [
Decisions analyzed:
function out = rect_intersectirect? rect2) 100%
=
executed 8/
4

This table indicates that the subfunction rect_intersect executed during
testing.

Coverage for Line 22. Coverage metrics for line 22 appear below the
coverage metrics for line 9.

%Vintersecting_rectangles Coverage Report 1[ = |EI|1|
File Edit ‘Web Desktop Window Help
J « * S | @ | M |L0c:ati0n: ID:Workmd0deIs.l’eml.l’emI_bI0c:k.l‘model_c:0verage.ﬂrdersecting_redangles_cov.Html IZI
#22: if (top1 < bottom?2 || top2 < hottom1) =l
Decisions analyzed:
if {top1 < battomnZ || top2 < hottomn1) 100%
false 5/
true 348
Conditions analyzed:
Description: True | False
top1 < bottorm2 2 B
top2 < bottom? 1 g
MC/DC lysis (combinati in parentt did not occur)
Decision/Condition: True Qut False Out
top1 < bottom2 || top2 < bottomn1
top1 < bottorm2 Tx FF i
top2 < bottom? FT FF
4
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The Decisions analyzed table indicates that there are two possible outcomes
for the decision in line 22: true and false. Five of the eight times it was
executed, the decision evaluated to false, and the remaining three times, it
evaluated to true. Because both possible outcomes occurred, decision coverage
is 100%.

The Conditions analyzed table sheds some additional light on the decision
in line 22. Because this decision consists of two conditions linked by a logical
OR (] |) operation, only one condition must evaluate true for the decision to be
true. If the first condition evaluates to true, there is no need to evaluate the
second condition.The first condition, top1 < bottom2, was evaluated eight
times, and was true twice. This means that it was necessary to evaluate the
second condition only six times. In only one case was it true, which brings the
total true occurrences for the decision to three, as reported in the Decisions
analyzed table.

MCDC coverage looks for decision reversals that occur because one condition
outcome changes from T to F or from F to T. The MCDC analysis table
identifies all possible combinations of outcomes for the conditions that lead
to a reversal in the decision. The character x is used to indicate a condition
outcome that is irrelevant to the decision reversal. Decision-reversing
condition outcomes that are not achieved during simulation are marked with a
set of parentheses. There are no parentheses, therefore all decision-reversing
outcomes occurred and MCDC coverage is complete for the decision in line 22.

Coverage for Line 25. Coverage metrics for line 25 appear below the
coverage metrics for line 22.
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%Yintersecting_rectangles Coverage Report 1[ - |EI|1|

File Edit ‘Web Desktop Window Help

J - = | @ | i |L0c:ati0n: ID:.Work.l'ModeIS.l’eml.femI_bloc:k.l'm0deI_c:0verage.ﬂr‘derseding_redangles_cov.Html IZI

=

#25: if {right1 < left? || right? < left1)

Decisions analyzed:

if (right1 < |eft2 || right2 < left1) 100%
false 35
true 2/

Conditions analyzed:

‘ Description: ‘ True ‘ False
right1 < left2 a 5]
‘ right2 < left1 ‘ 2 ‘ 3
MC/DC lysis (combinati in parentt did not occur)
Decision/Condition: True Qut ‘ False Out

right1 < left2 || right2 < left1

right1 < left2 (Tx) FF

right2 < left1 ‘ FT ‘ FF

-

4

The line 25 decision, if (right1 < left2 || right2 < left1), is nested in
the if statement of the line 22 decision and is evaluated only if the line 22
decision is false. Because the line 22 decision evaluated false five times, line
25 is evaluated five times, three of which were false. Because both the true
and false outcomes were achieved, decision coverage for line 25 is 100%.

Because line 25, like line 22, has two conditions related by a logical OR
operator (| |), condition 2 is tested only if condition 1 is false. Because
condition 1 tests false five times, condition 2 is tested five times. Of these,
condition 2 tests true two times and false three times, which accounts for the
two occurrences of the true outcome for this decision.

Because the first condition of the line 25 decision does not test true, both

outcomes did not occur for that condition and the condition coverage for
the first condition is highlighted with a rose color. MCDC coverage is also
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highlighted in the same way for a decision reversal based on the true outcome
for that condition.

Coverage for run_intersect_test. The metrics that summarize coverage for
the entire run_intersect_test function are reported prior to its listing and
are repeated here as shown.

%" Web Browser - intersecting_rectangles Coverage | -3 =]
File Edit Go Desktop ‘Window Help E 4
Dw| % Rl o o BODE &0
J « * S | @ | M |L0c:ati0n: Izml.l’emI_bI0c:k.l‘model_c:0verage.ﬂrdersecting_redangles_cov.Html LI
Surnrnary | Details
Function "run_intersect_test”
Parent: intersecting_rectangles/etl
Uncovered Links: [
Metric Coverage
Cyclomatic Complexity 53
Decision (D1) 100% (5/8) decision outcomes
Condition (C1) 88% (7/8) condition outcomes
MCDC (C1) 75% (3/4) conditions reversed the outcome
” intersecting_... | |
4

The results summarized in the coverage metrics summary can be expressed
in the following conclusions:

® There are six decision outcomes reported for run_intersect_test in the
line reports: one for line 1 (executed), one for line 9 (executed), two for
line 22 (true and false), and two for line 25 (true and false). The decision
coverage for each line shows 100% decision coverage. This means that
decision coverage for run_intersect_test is six of six possible outcomes,
or 100%.

® There are four conditions reported for run_intersect test in the line
reports. Lines 22 and 25 each have two conditions, and each condition
has two condition outcomes (true and false), for a total of eight condition
outcomes in run_intersect_test. All conditions tested positive for both
the true and false outcome except for the first condition of line 25 (right1
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< left2). This means that condition coverage for run_intersect_test is
seven of eight, or 88%.

® The MCDC coverage tables for decision lines 22 and 25 each list two
cases of decision reversal for each condition, for a total of four possible
reversals. Only the decision reversal for a change in the evaluation of the
condition right1 < left2 of line 25 from true to false did not occur during
simulation. This means that three of four, or 75% of the possible reversal
cases were tested for during simulation, for a coverage of 75%.

Model Coverage for the Embedded MATLAB Function Block
and the Model

The model coverage report for the block Embedded MATLAB shows that it has
no decisions of its own apart from its function. However, it does repeat the
summary information for its function run_intersect_test as coverage for its
descendent objects, as shown.

%" Web Browser - intersecting_rectangles Coverage Rep 1[ - |EI|1|
File Edit Go Desktop ‘Window Help E 4
Dw| % Rl o o BODE &0
J « * 8 | @ | M |L0c:ati0n: ID:.Work.l'ModeIs.l’emI.l’eml_bIoc:k.l‘m0deI_c:overage.ﬂr‘derseding_redangles_cov.HtmlLI
Surnrnary | Details
A
2. EML Script block "eML"
Parent: fintersecting_rectangles _
Metric Coverage (this object) Coverage (inc. descendants)
Cyclomatic Complexity 0 53
Decision (D1) A, 100% (5/8) decision outcomes
Condition (C1) A, 88% (7/8) condition outcomes
. "
MCDC (1) NA, 75% (3/4) conditions reversed the
outcome
=
” intersecting_... | |
4

Because there are no additional coverage objects in the model apart from

the Embedded MATLAB Function block, the remaining report for the model
intersecting_rectangles also repeats the preceding coverage for descendent
objects, as shown.
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%V Web Browser - intersecting_rectangles Coverage Report 1[ - |EI|1|
File Edit Go Desktop ‘Window Help E 4
D& dBEBR o o HOHE =0

J - = | @ | i |L0c:ati0n: ID:.Work.l'ModeIs.l’emI.l’eml_bIoc:k.l‘m0deI_c:overage.ﬂr‘derseding_redangles_cov.HtmlLI

Surnrnary | Details
A
1. Model "intersecting_rectangles"
[
Child Systems: el
Metric Coverage (this object) Coverage (inc. descendants)
Cyclomatic Complexity 1 7
Decision (D1) A, 100% (5/8) decision outcomes
Condition (C1) A, 88% (7/8) condition outcomes
. "
MCDC (1) NA, 75% (3/4) conditions reversed the
outcome
” intersecting_... |
4




Functions — Categorical
List

Simulink Verification and Validation organizes its functions with the following
category topics:

“Requirements Management
Interface Functions” (p. 6-2)

“Model Coverage Functions” (p. 6-2)



6 Functions — Categorical List

Requirements Management Interface Functions

The following table lists and describes the requirements methods of Simulink
Verification and Validation.

Method Purpose
rminav Start Requirements Management
Interface

Model Coverage Functions

The following table lists and describes the model coverage methods of
Simulink Verification and Validation.

Method Purpose

cvhtml Produce HTML report from model
coverage objects in memory

cvload Load into memory the coverage tests
and results stored in a file

cvsave Save coverage tests and results to a
file

cvsim Simulate and return model coverage

results for test objects

cvtest Create a model coverage test
specification object
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Purpose

Syntax

Description

Produce HTML report from model coverage objects in memory

cvhtml(file, cvdo)
cvhtml(file, cvdol, cvdo2,...)
cvhtml(file, cvdol1, cvdo2,..., detail)

Use the cvhtml command to produce an HTML report from cvdata
objects you produce when you run a model coverage test in simulation.

cvhtml(file, cvdo) creates an HTML report of the coverage results
in the cvdata object cvdo, which is written to the file file in the current
MATLAB directory.

cvhtml(file, cvdol, cvdo2,...) creates a combined report of
several cvdata objects. The results from each object are displayed

in a separate column of the HTML report. Each cvdata data object
must correspond to the same root model or subsystem, or the function
produces errors.

cvhtml(file, cvdol, cvdo2,..., detail) creates a combined report
of several cvdata objects and specifies the detail level of the report with
the value of detail, an integer between 0 and 3. Greater numbers for
detail indicate greater detail. The default value is 2.



cvload

Pu rpose Load into memory the coverage tests and results stored in a file

Syntax [cvtos, cvdos]
[cvtos, cvdos]

cvload(filename)
cvload(filename, restoretotal)

Description The cvload command loads into memory the coverage tests and results
stored in a file by the cvsave command.

[cvtos, cvdos] = cvload(filename) loads the tests and data stored
in the text file filename.cvt. The cvtest objects that are successfully
loaded are returned in cvtos, a cell array of cvtest objects. The cvdata
objects that are successfully loaded are returned in cvdos, a cell array
of cvdata objects. cvdos has the same size as ctvos, but can contain
empty elements if a particular test has no results.

[cvtos, cvdos] = cvload(filename, restoretotal) restores

the cumulative results from prior runs if restoretotal is 1. If
restoretotal is unspecified or 0, the model’s cumulative results are
cleared.

cvload Special Considerations
The following are some special considerations for using the cvload

command:

¢ If a model with the same name exists in the coverage database, only
the compatible results that reference the existing model are loaded to
prevent duplication.

¢ If the Simulink models referenced from the file are open but do not
exist in the coverage database, the coverage tool resolves the links to
the existing models.

® When you are loading several files that reference the same model,
only the results that are consistent with the earlier files are loaded.
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Purpose

Syntax

Description

Save coverage tests and results to a file

cvsave(filename, model)
cvsave(filename, cvtol, cvto2, ...)
cvsave(filename, cvdol, cvdo2, ...)

Save the coverage tests and results from simulations to a file with the
function cvsave.

cvsave(filename, model) saves all the tests (cvtest objects) and
results (cvdata objects) in memory related to the model model in the
text file filename.cvt.

cvsave(filename, cvtol, cvto2, ...) saves the testsin the cvtest
objects cvtol, cvto2, ... in the text file filename.cvt. Information
about the referenced models is also saved.

cvsave(filename, cvdol, cvdo2, ...) saves the tests, test results,
and referenced models’ structure for cvdata objects cvdol, cvdo2, ... to
the text file filename.cvt.



cvsim

Pu rpose Simulate and return model coverage results for test objects
Syntax cvdo = cvsim(cvto)
[cvdo,t,x,y] = cvsim(cvto)

[cvdo,t,x,Vy]
[cvdo,t,x,y]

(
cvsim(cvto, timespan, options)
cvsim(cvto, label, setupcmd)

[cvdol, cvdo2, ...] cvsim(cvtol, cvto2, ...)
Description You simulate a test specification object (a cvtest object) with the cvsim
command.

Note You do not have to enable model coverage reporting for the model
to use the cvsim command.

cvdo = cvsim(cvto) executes the cvtest object cvto by starting a
simulation run for the corresponding model. The results are returned
in the cvdata object cvdo.

[cvdo,t,x,y] = cvsim(cvto) returns the time vector t, matrix of
state values x, and matrix of output values y from the simulation.
See online help for the MATLAB sim command for descriptions of the
parameters t, x, and y.

[cvdo,t,x,y] = cvsim(cvto, timespan, options) returns the time
vector t, matrix of state values x, and matrix of output values y from the
simulation, and overrides default simulation values with the values for
timespan and options. See online help for the MATLAB sim command
for descriptions of the parameters t, x, y, timespan, and options.

[cvdo,t,x,y] = cvsim(cvto, label, setupcmd) creates the cvtest
object cvto and simulates it in one command. The arguments label and
setupcmd are passed directly to the cvtest command, which creates the
cvtest object cvto.

[cvdo1l, cvdo2, ...] = cvsim(cvtol, cvto2, ...) executes the
cvtest objects cvto1, cvto2, ... and returns the results in the set of
cvdata objects cdvo1, cvdo2,
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Purpose Create a model coverage test specification object

Syntax cvto = cvtest(root)
cvto cvtest(root, label)
cvto = cvtest(root, label, setupcmd)

Description The cvtest command creates a test specification object, that you
simulate with the cvsim command.

cvto = cvtest(root) creates a test object with the handle cvto. root
is the name of, or a handle to, a Simulink model or a subsystem of a
model. Only the specified model or subsystem and its descendants are
subject to model coverage testing.

cvto = cvtest(root, label) creates a test object with the label
label, which is used for reporting results.

cvto = cvtest(root, label, setupcmd) creates a test object with the
setup command setupcmd and labels it with 1abel. The setup command
is executed in the base MATLAB workspace just prior to running the
instrumented simulation. This command is useful for loading data
prior to a test.

A test object has the following structure.

Field Description

id Read-only internal data-dictionary ID

modelcov Read-only internal data-dictionary ID

rootPath Name of the system or subsystem
instrumented for analysis

label String used when reporting results

setupCmd Command executed in the base workspace
just prior to simulation

settings.decision Set to 1 if Decision Coverage is desired

settings.condition Set to 1 if Condition Coverage is desired
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cvtest

Field

Description

settings.mcdc

Set to 1 if MC/DC coverage is desired

settings.tableExec

Set to 1 if lookup table coverage is desired
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rminav

7-8

Purpose
Syntax

Description

Start Requirements Management Interface
rminav

rminav starts the deprecated Requirements Management Interface
Navigator window.

If you specified reqsys = 'OTHERS' in the MATLAB file reqmgropts.m,
the standard version of the Requirements Management Interface
Navigator window opens. You can associate requirements documents
written in HTML, Microsoft Word, or Microsoft Excel with Simulink
models, Stateflow diagrams, and MATLAB M-files.

If you specified reqsys = 'DOORS' in reqmgropts.m, the DOORS
version of the Requirements Management Interface Navigator window
opens. You can associate DOORS requirements with Simulink models,
Stateflow diagrams, and MATLAB M-files.

To associate DOORS requirements with MATLAB objects, you must
start MATLAB with the /automation option.
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System Requirements

8-2

Purpose
Library

Description

List system requirements in Simulink diagrams
Simulink Verification and Validation

The System Requirements block lists all the system requirements
associated with the model or subsystem depicted in the current
diagram. It does not list requirements associated with individual blocks
in the diagram.

You can place this block anywhere in a diagram. It is not connected
to other Simulink blocks. You cannot have more than one System
Requirements block in a diagram.

When you drag the System Requirements block from the library
browser into your Simulink diagram, it is automatically populated with
the system requirements, as shown.

E!my_sf_car,.-"Engine & - |EI|1|
File Edit WYiew Simulation Format Tools Help
DSE&| $BR <2 » =0 [Momal =] O e (21 & 3 | B
Ti
= D
thmttle i s j— e
engine engine + impelier
tomue inertiz,
Syatern Reguirementa
1. ‘Requirerment 1*
2. "Requirement 2*
3. "Reguirement 3°
Ready [1o02 [ [ |odes v

Each of the listed requirements is an active link to the actual
requirements document. When you double-click on a requirement name,
the associated requirements document opens in its editor window,
scrolled to the target location.



System Requirements

If the System Requirements block exists in a diagram, it automatically
updates the requirements listing as you add, modify, or delete
requirements for the model or subsystem.

For more information on using the System Requirements block, see
“Displaying the System Requirements in a Diagram” on page 2-49.

Dialog To access the Block Parameters dialog box for the System Requirements

Box and block, right-click on the System Requirements block and, from

Parameters the resulting pop-up menu, select Mask Parameters. The Block
Parameters dialog box opens, as shown.

E Block Parameters: System Requirements x|

— Spstem Requirements [mazk)

Lizts the requirements for the current model.

—Parameters

Block, Title

Systemn Fequirements L

Ok I Cancel | Help | Apply |

The Block Parameters dialog box for the System Requirements block
contains one parameter.

Block Title
The title of the system requirements list in the diagram. The
default title is System Requirements. You can type a customized
title, for example, Engine Requirements.
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Examples

Use this list to find examples in the documentation.



A

Examples

Requirements Management Interface

“Adding Requirement Links to an Object” on page 2-8

“Viewing Requirements Documents” on page 2-13

“Making Selection-Based Links” on page 2-22

“Creating a Custom Link Requirement Type” on page 2-31
“Viewing Objects with Requirement Links” on page 2-44
“Generating a Requirements Report” on page 2-47

“Displaying the System Requirements in a Diagram” on page 2-49
“Including Requirements with Generated Code” on page 2-55



Requirements Management Interface - DOORS Version

Requirements Management Interface - DOORS Version

“Linking Objects to DOORS Requirements” on page 3-7
“Synchronizing a Model with DOORS” on page 3-13
“Navigating from Simulink to DOORS” on page 3-26
“Navigating from DOORS to Simulink” on page 3-28



A Examples

Verification Manager

“Opening the Verification Manager” on page 4-5

“Enabling and Disabling Model Verification Blocks with the Verification
Manager” on page 4-9

“Using Enabling and Disabling Tools in the Verification Manager” on page
4-13

“Managing Verification Requirements” on page 4-17



Model Coverage

Model Coverage

“Details Report Section” on page 5-20

“Decisions Analyzed Table” on page 5-22

“Conditions Analyzed Table” on page 5-22

“MC/DC Analysis Table” on page 5-23

“N-Dimensional Lookup Table Report” on page 5-25

“Signal Range Analysis Report” on page 5-31

“Displaying Model Coverage with Model Coloring” on page 5-35
“Creating a Model with Embedded MATLAB Function Block Decisions”
on page 5-46

“Understanding Embedded MATLAB Function Block Model Coverage”
on page 5-49



A Examples




A

adding links to requirements 2-8
adding requirements 2-5
Assert block appearance 4-12

C

categorical lists of functions 6-1
changing links to requirements 2-11
closing Signal Builder Requirements pane 4-8
colored diagram model coverage display 5-34
enabling 5-34
condition coverage
Embedded MATLAB Function blocks 5-56
statements in Embedded MATLAB
Function block 5-46
configuring MATLAB
for DOORS version 3-5
cvhtml function
model coverage 5-42
reference 7-2
cvload function
model coverage 5-43
reference 7-3
cvsave function
model coverage 5-42
reference 7-4
cvsim function
model coverage 5-41
reference 7-5
cvtest function
model coverage 5-39
reference 7-6

D

decision coverage
Embedded MATLAB Function blocks 5-56
statements in Embedded MATLAB
Function blocks 5-45

demos
simcovdemo model coverage demo 5-7
disabling Model Verification blocks across test
groups 4-13
DOORS
additional installation for 3-3
starting 3-5
DOORS Requirements Management Interface
block type descriptions 3-16
definition for object 3-13
from Simulink to DOORS 3-26
hierarchical numbers 3-16
naming of surrogate exported module 3-16
object identifiers 3-16
opening the object in Simulink, Stateflow,
or MATLAB 3-30
overview 3-2
saving formal modules 3-19
starting MATLAB for 3-5
synchronizing models with DOORS 3-13
synchronizing objects with DOORS formal
module 3-13
viewing model elements with
requirements 3-24
viewing requirements 3-24
DOORS version required 1-3

Embedded MATLAB Function blocks
condition coverage 5-56
condition coverage statements 5-46
decision coverage 5-56
decision coverage statements 5-45
MCDC coverage 5-57
MCDC coverage statements 5-46
model coverage 5-45
model coverage example 5-46
types of model coverage 5-45

Index-1



Index

enabling Model Verification blocks across test

F

groups 4-13

functions

categorical lists of 6-1

cvhtml 7-2

cvload 7-3

cvsave 7-4

cvsim 7-5

cvtest 7-6

model coverage 6-2

rminav 7-8

start old Requirements Management
Interface 6-2

icons for Model Verification blocks in

Verification Manager 4-10

installing DOORS 3-3

L

linking model objects to requirements 2-8
Lookup Table block in model coverage

report 5-25

Lookup Table model coverage

M

n-dimensional 5-30
three-dimensional example 5-27
two-dimensional example 5-25

MATLAB version required 1-3
MCDC coverage

Embedded MATLAB Function blocks 5-57
statements in Embedded MATLAB
Function blocks 5-46

MCDC table

Index-2

condition cases 5-23

model coverage
colored Simulink diagram display 5-34
colored simulink diagram example 5-35
commands in MATLAB 5-39
Embedded MATLAB Function blocks 5-45
enabling colored diagram display 5-34
enabling colored simulink diagram

display 5-34
HTML settings 5-14
introduction 5-3
Lookup Table block report 5-25
MCDC table 5-23
n-dimensional Lookup Table 5-30
settings in dialog 5-10
signal range analysis report 5-31
Summary report section 5-19
three-dimensional Lookup Table
example 5-27

two-dimensional Lookup Table 5-25
understanding report 5-19

model coverage demo
simcovdemo 5-7

model coverage functions 6-2
cvhtml 5-42
cvload 5-43
cvsave 5-42
cvsim 5-41
cvtest 5-39

Model Verification blocks
block appearance 4-10
disabling for test groups 4-9
enabling for test groups 4-9
icons 4-10
parameter settings 4-2
using individually 4-2

models
running test cases 5-7

modifying requirements 2-5



Index

o

objects
linking model objects to requirements 2-8
viewing objects with requirements 2-44
old Requirements Management Interface 6-2
opening a Signal Builder block 4-6
operating system requirements 1-3

P

parameters for Model Verification blocks 4-2

report
model coverage HTML options 5-14
understanding model coverage report 5-19
requirements
adding 2-5
adding to test groups 4-18
for Model Verification block settings 4-17
for Requirements Management Interface
for DOORS 3-2
in generated code 2-55
linking to model objects 2-8
modifying 2-5
viewing 2-5
viewing for test groups 4-19
viewing objects with 2-44
requirements documents
editing 2-13
viewing 2-13
requirements links
editing 2-11
Requirements Management Interface
overview 2-3
Requirements Management Interface for
DOORS
block type descriptions 3-16
definition of object in DOORS 3-13

from Simulink to DOORS 3-26

hierarchical numbers 3-16

naming of surrogate exported
modules 3-16

object identifiers 3-16

opening the object in Simulink or
Stateflow 3-30

overview 3-2

saving formal modules 3-19

starting 3-5

starting MATLAB for 3-5

synchronizing models with DOORS 3-13

synchronizing objects with DOORS formal
module 3-13

viewing model elements with
requirements 3-24

viewing requirements 3-24

Requirements pane for Verification
Manager 4-17
rminav function
reference 7-8

S

Signal Builder block
opening 4-6

Signal Builder dialog box
closing Verification Manager Requirements

pane 4-8

signal range analysis report in model
coverage 5-31

simcovdemo
model coverage demo 5-7

Simulink version required 1-3

starting DOORS 3-5

starting MATLAB for DOORS 3-5

starting Requirements Management Interface
for DOORS 3-5

Stateflow version required 1-3
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Summary section of model coverage
report 5-19
synchronizing models with DOORS 3-13
system requirements 1-3
DOORS 1-3
MATLAB 1-3
operating system 1-3
Simulink 1-3
Stateflow 1-3

T

test case commands 5-7
test groups
adding requirements 4-18
disabling Model Verification blocks 4-9
enabling Model Verification blocks 4-9
Model Verification blocks enabled
across 4-13

v

verification blocks

Index-4

example of use 4-2

icons 4-10

requirements for test groups 4-17
stopping simulation 4-4

Verification Manager

closing Requirements pane 4-8

disabling Model Verification blocks for test
groups 4-9

enabled/disabled block appearance 4-10

enabling Model Verification blocks for test
groups 4-9

flat display 4-8

hierarchical display 4-8

icons for Model Verification blocks 4-10

opening 4-5

Requirements pane 4-17

viewing objects with requirements 2-44
viewing requirements 2-5
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